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Preface

As part of an effort to improve and enhance the performance and capabilities of its product 
lines, EMC periodically releases revisions of its hardware and software. Therefore, some 
functions described in this document may not be supported by all versions of the software or 
hardware currently in use. For the most up-to-date information on product features, refer to 
your product release notes.

If a product does not function properly or does not function as described in this document, 
please contact your EMC representative.

Audience This document is part of the NetWorker documentation set, and is intended for use 
by system administrators during the installation and setup of NetWorker software in 
a cluster environment.

Related
documentation

For more information about NetWorker software, refer to this documentation:

◆ EMC NetWorker Release 7.4 Service Pack 1, Administration Guide

◆ EMC NetWorker Release 7.4, Release 7.4 Service Pack 1 Multiplatform Version, 
Installation Guide

◆ EMC NetWorker Release 7.4 Service Pack 1 Multiplatform Version Release Notes

◆ EMC Information Protection Software Compatibility Guide

Conventions used in
this guide

EMC uses the following conventions for notes, cautions, and important notices.

Note: A note presents information that is important, but not hazard-related.

CAUTION!
A caution contains information essential to avoid data loss or damage to the system 
or equipment. 

IMPORTANT!
An important notice contains information essential to operation of the software. 
EMC NetWorker Release 7.4 Service Pack 1 Multiplatform Version Cluster Installation Guide 9
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Typographical conventions
EMC uses the following style conventions in this guide:

Normal Used in running (nonprocedural) text for:
• Names of interface elements (such as names of windows, dialog boxes, buttons, 

fields, and menus)
• Names of resources, attributes, pools, Boolean expressions, buttons, DQL 

statements, keywords, clauses, environment variables, filenames, functions, utilities
• URLs, pathnames, filenames, directory names, computer names, links, groups, 

service keys, file systems, notifications

Bold: Used in running (nonprocedural) text for:
• Names of commands, daemons, options, programs, processes, services, 

applications, utilities, kernels, notifications, system call, man pages

Used in procedures for:
• Names of interface elements (such as names of windows, dialog boxes, buttons, 

fields, and menus)
• What user specifically selects, clicks, presses, or types

Italic: Used in all text (including procedures) for:
• Full titles of publications referenced in text
• Emphasis (for example a new term)
• Variables

Courier: Used for:
• System output, such as an error message or script 
• URLs, complete paths, filenames, prompts, and syntax when shown outside of 

running text 

Courier bold: Used for:
• Specific user input (such as commands) 

Courier italic: Used in procedures for:
• Variables on command line
• User input variables 

< > Angle brackets enclose parameter or variable values supplied by the user

[ ] Square brackets enclose optional values

| Vertical bar indicates alternate selections - the bar means “or”

{ } Braces indicate content that you must specify (that is, x or y or z)

... Ellipses indicate nonessential information omitted from the example
EMC NetWorker Release 7.4 Service Pack 1 Multiplatform Version Cluster Installation Guide10
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Where to get help
EMC support, product, and licensing information can be obtained as follows.

Product information —  For documentation, release notes, software updates, or for 
information about EMC products, licensing, and service, go to the EMC Powerlink 
website (registration required) at:

http://Powerlink.EMC.com

Technical support —  For technical support, go to EMC Customer Service on 
Powerlink. To open a service request through Powerlink, you must have a valid 
support agreement. Please contact your EMC sales representative for details about 
obtaining a valid support agreement or to answer any questions about your account.

Your comments
Comments and suggestions about our product documentation are always welcome. 

To provide feedback:

1. Go to:

http://Powerlink.EMC.com

2. Click the Feedback link.
EMC NetWorker Release 7.4 Service Pack 1 Multiplatform Version Cluster Installation Guide 11
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Introduction
About the NetWorker product
The EMC® NetWorker®  product is a suite of storage management software that 
provides backup, recovery, and other services to computers with a wide variety of 
operating systems and data types. NetWorker products for different operating 
systems are interoperable. This provides the flexibility to design a storage 
management system that works best with the current computing environment.

The NetWorker software is distributed in these formats:

◆ In a media kit that contains the software and electronic documentation for several 
related NetWorker products.

◆ As a downloadable archive file from the EMC website.

The NetWorker product has five major components: 

◆ NetWorker client

◆ NetWorker storage node

◆ NetWorker server

◆ NetWorker Management Console

◆ NetWorker License Manager

NetWorker client
The NetWorker client software communicates with the NetWorker server and 
provides recover and ad hoc (manual) backup functionality. The NetWorker client 
software is installed on all computers that are backed up to the NetWorker server. 

NetWorker storage node
Data can be backed up directly to devices that are attached to a NetWorker server, or 
to a NetWorker storage node. A storage node controls storage devices such as tape 
drivers, autochangers, and silos. 

Storage nodes depend on the NetWorker server for these functions:

◆ Control over which clients use the storage node’s devices for backups

◆ License management

◆ Management of the client file indexes that track each client’s data

◆ Management of the media database that tracks the data on each volume

NetWorker storage nodes and the NetWorker server can use different operating 
systems. To use a NetWorker storage node on a Linux operating system with a 
NetWorker server that is running another operating system, the storage node’s 
enabler on the server must be of the same edition as the base enabler for the 
NetWorker server.

NetWorker server
The NetWorker server software provides control and scheduling for NetWorker 
operations. It enables you to:
EMC NetWorker Release 7.4 Service Pack 1 Multiplatform Version Cluster Installation Guide14
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◆ Enter the enabler licenses for the NetWorker server and all the functions the 
NetWorker server controls, such as autochanger modules, and additional client 
connections.

◆ Define the clients, devices, and media that the NetWorker server controls.

◆ Define the schedules for backups and other operations.

◆ Monitor the results of backups and other operations.

◆ Manage the client file indexes that track each client’s data.

◆ Manage the media database that tracks the data contained on each volume.

NetWorker de-duplication node

Data de-duplication is a method of backup that identifies redundant data segments at 
the source and backs up only unique segments, thereby reducing the time required to 
perform backups and both the network bandwidth and storage space used for 
backups. The NetWorker software uses EMC Avamar® technology to provide 
de-duplication.

A NetWorker de-duplication node is an EMC Avamar server that stores 
de-duplicated backup data. The initial backup to a de-duplication node should be a 
full backup. During subsequent backups, the Avamar infrastructure identifies 
redundant data segments at the source and backs up only unique segments. This 
reduces the time required to perform backups, as well as both the network 
bandwidth and storage space used for backups.

Avamar server installation is separate from NetWorker installation, and is performed 
by EMC Professional Services. The Avamar server must be configured as a 
NetWorker de-duplication node. The Avamar server must be available when:

◆ A de-duplication client resource is created.

◆ The Avamar server receives backup data from NetWorker de-duplication clients.

The Avamar server must have the NetWorker client software installed in order to 
function as a de-duplication node. The installation of NetWorker client software on 
the Avamar server must be performed by EMC Professional Services.

NetWorker Management Console
All NetWorker servers and clients are managed from the NetWorker Management 
Console. The Console replaces the NetWorker Administration program (nwadmin) 
which is no longer available.

To administer NetWorker servers, the Console must be:

◆ Installed on an AIX, HP-UX, Linux, Solaris, or Microsoft Windows host.

◆ Accessed through a graphical user interface on the host with a web-enabled 
browser that has the specified version of Java Runtime configured.

The Console provides reporting, managing, and monitoring capabilities for all 
NetWorker servers and clients. Multiple users can access the Console server 
concurrently from different browser sessions. A computer that hosts the web-enabled 
browser can also be a NetWorker client, server, or storage node.

You must install the Console software on one computer in your datazone to manage 
and monitor the NetWorker server. Only one installation of the Console is required to 
manage multiple NetWorker servers and to take full advantage of the Console’s 
consolidated reporting feature.
About the NetWorker product 15
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NetWorker License Manager

The NetWorker License Manager provides a central location for managing the 
licenses of all the NetWorker clients and servers. Instead of managing licenses 
separately, all NetWorker licenses can be maintained from a single computer. 
Installation of the NetWorker License Manager software is an option when installing 
the NetWorker software.

The NetWorker License Manager Installation and Administration Guide and the 
NetWorker License Manager Release Notes provides information about the 
NetWorker License Manager.

Mac OS X Client software

Currently, only the NetWorker client software is available for the Mac OS X 
operating system. You must use the Mac OS X client in conjunction with a supported 
UNIX, Linux, or Windows version of the NetWorker server.

The Mac OS X client software provides the following features:

◆ Full compatibility with NetWorker server and storage nodes on UNIX, Linux and 
Windows platforms, for NetWorker release 6.1.2 or later.

◆ HFS/HFS+ metadata awareness. This compatibility ensures the proper backup 
and restore of Mac OS X field metadata including resource forks, catalog 
information and 10.4 extended file attributes and access control files.

The following limitations apply to the Mac OS X client software:

◆ There is no graphical user interface (GUI) for this release, however there is full 
support of the command line interface (CLI).

◆ NetWorker software does not support recovery of Mac OS X save sets to 
non-Mac OS X clients.

◆ NetWorker software does not support recovery of Mac OS X 10.4 save sets to 
Mac OS X 10.3 clients.

Supported devices
NetWorker software supports a variety of media types and devices, either 
stand-alone or in an autochanger or silo tape library. Devices can be attached to a 
NetWorker server or designated storage node. 

The term autochanger refers to a variety of backup devices: 

◆ Autoloader 

◆ Carousel

◆ Datawheel

◆ Jukebox

◆ Library

◆ Near-line storage

The EMC Information Protection Software Compatibility Guide provides the latest 
list of supported devices. 
EMC NetWorker Release 7.4 Service Pack 1 Multiplatform Version Cluster Installation Guide16
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Enabler codes
Enabler codes (licenses), which activate the functionality of NetWorker software are 
sold separately. The section “Licensing and Enabling the Software” on page 143 
provides information.
Enabler codes 17
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Software installation roadmap
Use the following roadmap when installing the NetWorker software:

1. Review “Installation requirements” on page 20 and note the default directory 
location.

2. Install the required NetWorker software by following one of these procedures::

• “Installing a NetWorker virtual server” on page 22

• “Installing only the NetWorker client software in a cluster” on page 27

3. Enable and register all of the NetWorker products. Chapter 10, ”Licensing and 
Enabling the Software‚" provides detailed information.

Installation requirements
This section specifies the software and hardware required to install and configure the 
NetWorker server or client software within an AutoStartTM cluster environment.

The EMC Information Protection Software Compatibility Guide provides the most 
up-to-date software and hardware requirements.

Software requirements
The following software must be installed on each node in the cluster.

Cluster server
This software must be installed on the cluster server:

◆ Windows 2000 Server/Advanced Server (latest Service Pack installed) or later

◆ EMC AutoStart release 5.1 or later

◆ Dedicated shared disk to be used as the NetWorker storage disk (for the nsr 
folder) connected to all the nodes within the cluster

◆ Device with local affinity for the local bootstrap backup

Note: Ensure that the most recent cluster patch for the operating system is installed.

Cluster client
This software must be installed on the private disk of each node in the cluster:

◆ Windows 2000 Server/Advanced Server (latest Service Pack installed) or later

◆ EMC AutoStart release 5.1 or later

Hardware requirements
There are no hardware requirements for the cluster client. The following hardware 
requirements must be met for server installation only:

◆ Dedicated shared disk that is used as the NetWorker storage disk (for the /nsr 
directory) is connected to all the nodes within the cluster.

◆ Device with local affinity for the local bootstrap backup is connected to all the 
nodes within the cluster.
EMC NetWorker Release 7.4 Service Pack 1 Multiplatform Version Cluster Installation Guide20
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Configuration options

The NetWorker Administration Guide provides information on how to configure:

◆ Tape libraries with a NetWorker virtual server

◆ Remote physical storage node with a NetWorker virtual server

System information requirements

Figure 1 on page 21 and Table 1 on page 21 illustrate the system information needed 
to install NetWorker software within an AutoStart environment.

Different platforms use different terms for the same cluster concepts. AutoStart refers 
to:

◆ Physical hosts as nodes

◆ Virtual server as a resource group (application service)

Figure 1 Sample cluster configuration

Node 1 
clus_phys1

Node 2 
clus_phys2

Private NetWork

Local Disk Local Disk
clus_log1

NetWorker 
Logical Host

If Node1fails,
clus_log1 fails
over to Node2

Public NetWork

Volume-managed Shared Disks

Terminal Concentrator

Administrative 
Workstation

Table 1 Information required during NetWorker virtual server installation  (1 of 2)

Required information Example

Pathname for the shared nsr directory s:\nsr

Server name of the NetWorker virtual server jupiter

Server netmask 255.255.255.0
Installation requirements 21
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Updating the NetWorker software 
To update the NetWorker server software in an AutoStart environment:

1. Start the EMC AutoStart Console and take the NetWorker server Cluster 
resource group offline.

2. Rename the NetWorker.clustersvr file to NetWorker.nocluster. 

This file is typically located in %SystemDrive%\Program Files\Legato\nsr\bin.

3. Upgrade the NetWorker software. The NetWorker Installation Guide provides 
instructions.

4. Stop the NetWorker Backup and Recover Server service.

5. Open the NetWorker Backup and Recover Server service properties and change 
the Startup type from Automatic to Manual.

6. Rename the NetWorker.nocluster file back to NetWorker.clustersvr.

7. Repeat steps 2 through 6 on the second node of the cluster.

8. Bring the NetWorker server cluster resource group back online.

Installing a NetWorker virtual server
To install and configure the NetWorker software as a highly available service in a 
cluster, complete these tasks:

◆ “Task 1: Ensure that the EMC AutoStart software is installed” on page 23

◆ “Task 2: Install the NetWorker software in a cluster” on page 23

◆ “Task 3: Promote at least one secondary cluster node to primary” on page 23

◆ “Task 4: Create the resource that will become the managed shared disk” on 
page 23

◆ “Task 5: Define the NetWorker server as highly available” on page 24

◆ “Task 6: Configure the NetWorker virtual server” on page 25

◆ “Task 7: Configuring the clients of the NetWorker cluster server” on page 26

◆ “Task 8: Register NetWorker licenses for cluster server failover” on page 27

Domain name for the AutoStart server (Domain names are 
case-sensitive)

 galaxy

Installation directory pathname C:\Program Files\Legato\ AAM\galaxy 

Server names of first and second physical hosts in the 
AutoStart Cluster. Server names must not exceed fifteen 
characters in length.

mars
saturn

Table 1 Information required during NetWorker virtual server installation  (2 of 2)

Required information Example
EMC NetWorker Release 7.4 Service Pack 1 Multiplatform Version Cluster Installation Guide22
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Task 1: Ensure that the EMC AutoStart software is installed

Ensure that the AutoStart software is installed. The AutoStart documentation 
provides detailed installation instructions.

For EMC AutoStart Release 5.1.2, you must install this patch:

ftp://ftp.legato.com/pub/cluster/patches/5.1/windows
/A_WIN_HF_5.1.2_79520.exe

Task 2: Install the NetWorker software in a cluster

On each node in the cluster, install NetWorker server software in the same location 
on a private disk, for example, in %SystemDrive%\Program Files\Legato\nsr.

To install the NetWorker software:

1. Log in as administrator on one node.

2. Install this NetWorker software on each node in the cluster:

• NetWorker client

• Storage node

• NetWorker server

Detailed instructions are provided in the EMC NetWorker Installation Guide.

3. Obtain the NetWorker hostid:

a. Launch the NetWorker Management Console software.

b. From the Administration windows, select Registration from the 
Configuration menu.

c. Right-click NetWorker/10 Eval and select Properties.

The value that is displayed in the HostID field is the hostid for the node on which 
NetWorker server is running. You will need this HostID later in the installation.

4. Repeat steps 1 through 3 on the second node.

Task 3: Promote at least one secondary cluster node to primary
You must always run two primary controllers. Promote at lease one secondary node 
to the primary by using the AutoStart Console. If one node fails, the other can be 
brought online automatically with all data.

The AutoStart documentation provides detailed instructions.

Task 4: Create the resource that will become the managed shared disk
On one of the cluster nodes, create a folder that you can later use as the managed, 
shared disk. For example, create the folder s:\nsr.

Note: Do not share the folder at this point. If you do, the installation will fail. If the AutoStart 
software is already installed and a managed shared disk already exists, remove the share 
property now.
Installing a NetWorker virtual server 23



EMC AutoStart for Microsoft Windows Installation
Task 5: Define the NetWorker server as highly available

To define the NetWorker server as a highly-available application, run the lc_config 
script on each node. By configuring the NetWorker server as a highly-available 
application, you create a NetWorker cluster group resource. This allows the 
NetWorker server to run in cluster mode (that is, with failover capability).

To run the lc_config script:

1. Log in as administrator.

2. Ensure that all node names to be used in the cluster, both the physical nodes and 
the virtual nodes, can be resolved using DNS.

To verify that the node names can be resolved by using DNS, type:

nslookup node_name

3. Start the NetWorker Backup and Recover Server services.

Note: If you are upgrading NetWorker software or reinstalling after a partial uninstall of 
the NetWorker software, the lc_config script prompts you to type a command to keep, 
rename or delete each of the old server configuration files. It is safe to delete the old files.

To delete a file, type d when prompted. After you finish typing your choices for 
each of the old configuration files, continue with step 5.

4. Run the lc_config script. 

When the lc_config script runs, you are prompted to type the information listed 
in Table 1 on page 21.

lc_config
C:\Program Files\Legato\nsr\bin>lc_config 
Checking for C:\Program 
Files\Legato\nsr\bin\lcmap.bat 
Checking for C:\Program Files\Legato\nsr\bin\NetWorker.clustersvr
Enter shared nsr dir:s:\nsr
Enter the Legato Cluster domain name:galaxy
Enter the directory in which your Legato Cluster software is 
installed (typically something like C:\galaxy):
C:\Program Files\Legato AAM\galaxy

5. Type y to confirm that the information is correct. 

If you need to make corrections, type n. The lc_config script runs again so that 
you can retype your information.

You entered the following data:
Nsr Dir = s:\nsr,
Legato Cluster domain = galaxy
Legato Cluster software location = C:\Program Files\Legato 
AAM\galaxy
Is this OK [y/n]y

6. Stop the NetWorker Backup and Recover Server services.

7. Edit the nw_nt.aam5.imp file and modify these fields:

• Virtual hostname

• Physical cluster node names

• Shared drive letter

The #NW customise label tag appears before each field that requires modification.
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8. On one node only, go to %SystemDrive%\Program Files\Legato\nsr\bin and 
run the following command. For example, if the AutoStart domain name is 
galaxy, type:

“C:\Program Files\Legato AAM\galaxy\bin\ftcli” -d galaxy -c "import 
nw_nt.lc.imp"

The screen displays this information:

C:\Program Files\Legato\nsr\bin>"C:\Program Files\Legato 
AAM\galaxy\bin\ftcli" -domain galaxy -c "import nw_nt.aam5.imp"IP 
Address "guiro" Created
Process Class "nsrd" Created
Process "NSRserver" Created
Configuration "NSRserver" Created
Process Class "nsrexecd" Created
Process "NSRexecd" Created
Configuration "NSRexecd" Created
Data Source "networker_ds" Created
Resource Group "networker" Created
OK

9. Use the AutoStart Console to:

a. Verify that the NetWorker Server resource was created.

b. Share the managed shared disk (for example, s:\nsr).

c. Bring the NetWorker virtual server online.

d. Select the disk to be used for NetWorker virtual server storage and set the disk 
to be managed as a shared storage for each physical node in the cluster.

10. For each physical node in the cluster, ensure that the AutoStart Console user 
account, NT AUTHORITY\SYSTEM is included in the valid user list with 
administrator access.

11. Ensure that the value of the environment variable for the administrator user 
FT_DOMAIN is set to the AutoStart domain name.

12. From one node in the cluster:

a. Log in as administrator.

b. Ensure that the data source for the NetWorker virtual server is managed by 
the AutoStart Management Console. 

The data source for the NetWorker virtual server is defined as networker_ds 
in the NetWorker resource group.

c. Run this script from the directory where the NetWorker software was 
installed:

nwinst.bat

The AutoStart documentation provides instructions on using the AutoStart Console.

Task 6: Configure the NetWorker virtual server

To configure the NetWorker server:

1. Log in as administrator on the cluster node that is currently running the 
NetWorker server resource group.

2. Start the NetWorker Console software.
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3. From the Administration window, select Properties from the File menu.

a. For the Administrator attribute, add entries for any cluster nodes that are not 
already listed. For example:

root@hostname

b. Click OK.

Note: To restrict the set of NetWorker servers that can back up a particular client, edit the 
nsr\res\servers file and add the NetWorker virtual host as well as each cluster node to the list 
of servers.

Task 7: Configuring the clients of the NetWorker cluster server
To configure each client under the NetWorker server:

1. (Optional) Define save groups.

Note: In order for their save sets to restart after a virtual client or NetWorker server 
failover, save groups must have the Autorestart attribute enabled and the Manual Restart 
option disabled.

2. Make each physical client within the cluster a client of the NetWorker server. 

For each physical client in the cluster:

a. Create a new NetWorker client.

b. For the Name attribute, type the name of the physical client.

3. Make each virtual client within the cluster a client of the virtual NetWorker 
server. 

For each virtual client in the cluster:

a. Create a new NetWorker client.

b. For the Name attribute, type the name of the virtual client.

c. For the Remote Access attribute, add entries for each physical client within 
the cluster. For example:

root@clus_phys1

d. For the Group attribute, select a group.

The first time the NetWorker application runs, it creates the Client resource for 
the NetWorker virtual server. The NetWorker Administration Guide provides 
information.

4. Verify that the Client and Group resources have been properly configured by 
running a test probe. On the node where the NetWorker server resides, run this 
command:

savegrp -pv -c client_name group_name

If this test does not display the expected scheduled backups and index, create an 
empty file named pathownerignore in the directory where the NetWorker savefs 
command is installed. This allows a valid save set on a NetWorker client to be 
scheduled for backup. For example:

On each node of the cluster, type:

echo NUL: NetWorker_bin_dir\pathownerignore
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Note: A NetWorker scheduled save might use a default rather than a specified client index 
name. To override this default, run a manual save with the -c option: 
save -c client_name
To restrict the set of NetWorker servers that can back up a particular client, edit the 
%SystemDrive%\Program Files\Legato\nsr\res\servers file and add the NetWorker 
virtual host as well as each cluster node to the list of servers.

After the client configuration is complete:

◆ The NetWorker cluster server uses the IP address of the NetWorker virtual host 
regardless of which cluster node currently masters the NetWorker virtual server.

◆ The NetWorker cluster server takes the identity of the NetWorker virtual server’s 
hostname regardless of which cluster node is currently running the NetWorker 
service.

◆ The first time NetWorker software runs, it creates the client resource for the 
NetWorker virtual host. Client resources must be created manually for any 
cluster node to be backed up by the NetWorker virtual host.

Task 8: Register NetWorker licenses for cluster server failover
To register NetWorker licenses for cluster failover:

1. Ensure that the NetWorker virtual server is defined as part of a cluster.

2. Ensure that the NetWorker service is running.

3. Log in to the cluster node on which the NetWorker virtual server is running.

4. Create a file named hostids in the nsr\res directory.

5. Open the hostids file and add one line. For hostid values, use the NetWorker 
hostids values that were derived in “Task 2: Install the NetWorker software in a 
cluster” on page 23.

hostid1:hostid2

6. Restart the NetWorker virtual server by taking it offline and then bringing it back 
online.

7. Register the NetWorker software for permanent use. Chapter 10, ”Licensing and 
Enabling the Software‚" explains how to register NetWorker software.

Installing only the NetWorker client software in a cluster
To install NetWorker cluster client, read and follow the procedures for these tasks:

◆ “Task 1: Install the NetWorker cluster client software” on page 28

◆ “Task 2: Configure NetWorker client software as highly available” on page 28

Note: Make sure the NetWorker client software is installed on every node to be backed up in 
the cluster.
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Task 1: Install the NetWorker cluster client software

To install the NetWorker client software on each node in the cluster:

1. Ensure that the operating system is updated with the most recent cluster patch.

2. For AutoStart Release 5.1.2, you must install patch A_WIN_HF_5.1.2_79520.exe 
available on Powerlink.

3. Install the NetWorker client software on the physical disk of each node in the 
cluster to be backed up. Chapter 10, ”Licensing and Enabling the Software‚" 
explains how to register NetWorker software.

Task 2: Configure NetWorker client software as highly available

To configure the NetWorker server:

1. Make each physical client within the cluster a client of the NetWorker server. For 
each physical client in the cluster:

a. Create a new client.

b. For the Name attribute, type the name of the physical client.

Note: If a physical Client is backed up to a NetWorker server outside the cluster, the name 
of any virtual service that can run on the physical node must be added to the Remote 
Access list of the physical Client resource.

2. Make each virtual client within the cluster a client of the NetWorker server. For 
each virtual client in the cluster:

a. Create a new client. 

b. For the Name attribute, type the name of the NetWorker server.

c. For the Remote Access attribute, add entries for each physical client within 
the cluster. For example:

root@clus_phys1

d. For the Group attribute, select a group.

3. Schedule backups by using the NetWorker application. 

4. On each node in the cluster, run the cluster configuration program lc_config.

a. Log in as administrator on each node.

b. Run the lc_config program: 

lc_config

Note: When prompted for the shared nsr directory, you can leave the field blank.

c. Type y to confirm the information.

5. For each physical node in the cluster, ensure that the AutoStart Console user 
account, NT AUTHORITY\SYSTEM is included in the valid user list with 
administrator access. 
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Uninstalling the NetWorker software
To uninstall the NetWorker software from an AutoStart environment:

1. Take the NetWorker Resource Group offline.

2. Select and delete the NetWorker Resource Group from the Current Resource 
Group list.

3. Select and delete the NSRserver and the NSRexecd services.

4. Select and delete the networker_ds resource.

5. Select and delete the NetWorker virtual server IP Address.

6. Uninstall the NetWorker Server software from each node. The NetWorker 
Installation Guide provides instructions.

Note: If the NetWorker software will be reinstalled to the same location, ensure that the 
following files are deleted from the /bin subdirectory: NetWorker.clustersvr, lcmap.bat and 
winst.bat.

Configuring the NetWorker virtual server with a backup device
The NetWorker virtual server must be configured with storage node backup devices. 
The storage nodes that are used by the NetWorker virtual server can be devices 
attached to a remote system (external to the cluster). They can also be devices 
connected locally to any of the physical nodes in the cluster. A storage node device 
can be a stand-alone tape device or an autochanger. The NetWorker Administration 
Guide provides information about how to configure storage nodes.

The NetWorker server requires a local backup device to save the bootstrap and the 
server indexes. With release 6.0 or later, the NetWorker virtual server bootstrap and 
indexes can be also saved to a storage node. The storage node device, in such a case, 
must be attached to the cluster node on which the NetWorker virtual server is 
currently running.

This is the recommended device configuration for a NetWorker virtual server, release 
6.0 or later, that is running in a two-node AutoStart cluster:

◆ Each cluster node must be defined as a storage node for the NetWorker virtual 
server.

◆ In the AutoStart Console, the Preferences\’Storage Nodes attribute in the 
NetWorker virtual server Client resource lists the storage nodes that are enabled 
to store data for the client. 

Each of the storage nodes must be listed before you can list the nsrserverhost:

a. One cluster node

b. The other cluster node

c. The nsrserverhost

Note: The nsrserverhost must always be listed last in each client's storage node list.

NetWorker software does not allow the configuration of a storage node on a cluster 
node that is running the NetWorker server binaries. Consequently, before 
configuring a cluster node as a storage node, you must move the NetWorker virtual 
server to another node in the cluster.
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Troubleshooting
These sections contain troubleshooting tips for NetWorker software in an AutoStart 
environment.

Setting the shutdown wait timeout values
To prevent timing problems during failover, perform this procedure to increase the 
shutdown wait timeout value for the NSRserver service.

1. Start the EMC AutoStart Console and select the domain.

2. Select Resource Groups>NetWorker Resource group.

3. Select the Settings tab.

4. Select NSRserver from the list box and click Edit.

5. Increase the value for the Wait until service is stopped item.

NetWorker virtual server fails to start nsrmmd
If the NetWorker virtual server fails to start nsrmmd on a NetWorker storage node, 
the following error messages are sent to the NetWorker server daemon log:

06/08/00 10:00:11 nsrmon #217: connect to nsrexec prog 390113 vers 
1 on `uranus' failed: RPC error: Remote system error
06/08/00 10:00:11 nsrd: media notice: check storage node: uranus 
(RPC error: Remote system error)

06/08/00 10:00:11 nsrd: media info: restarting nsrmmd #1 on uranus 
in 2 minute(s)
06/08/00 10:02:12 nsrd: media info: restarting nsrmmd #1 on uranus 
now
06/08/00 10:02:42 nsrmon #183: connect to nsrexec prog 390113 vers 
1 on `

The error might be caused by the NetWorker Remote Exec service not running on the 
storage node. If the service is not running, do the following to restart the service:

1. Select Services from the Control Panel on the storage node.

2. Restart the service.

NetWorker server fails to back up a virtual cluster client
If a NetWorker server fails to backup a virtual cluster client, an error message could 
appear.

In this example, the following names appear:

◆ charon — Virtual cluster client running on pluto

◆ pluto — Physical cluster node

◆ neptune — NetWorker server
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06/19/00 12:56:57 nsrd: savegroup alert: test completed, 1 client(s) 
(charon Failed) charon:Q:\: No save sets with this name were found 
in the media database; performing a full backup
* charon:Q:\ save: RAP error: Unable to extract resource info for 
client pluto.legato.com.
* charon:Q:\ save: Cannot open save session with neptune.legato.com
* charon:Q:\ 1 retry attempted
* charon:Q:\: No save sets with this name were found in the media 
database; performing a full backup
* charon:Q:\ save: RAP error: Unable to extract resource info for 
client pluto.legato.com.
* charon:Q:\ save: Cannot open save session with neptune.legato.com
06/19/00 12:56:57 nsrd: runq: NSR group test exited with return code 
1.

This error might be occur because the NetWorker Client resources for each of the 
physical nodes in the cluster are missing.

In such cases, perform the following to correct the error:

1. Create a Client resources for each physical node in the cluster that is allowed to 
own the virtual cluster client.

2. Rerun the backup.

Rolling back changes to the cluster configuration file
To roll back changes to the cluster configuration file (lc_config):

1. Take the NetWorker Resource Group offline.

2. Stop the NetWorker Remote Exec service.

3. Delete or rename these files from the NetWorker installation directory:

• NetWorker.clustersvr

• lcmap.bat

• nwinst.bat.

4. From the AutoStart Console, select and delete:

• NetWorker Resource Group

• NSRserver

• NSRexecd services

• networker_ds data source

• NetWorker virtual server IP address
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Software installation roadmap
An EMC AutoStart cluster consists of multiple nodes in a networked configuration 
and provides additional security with the failover capability. Failover allows another 
node in the cluster to take over operations from the first node. For information, refer 
to the AutoStart documentation.

Use the following roadmap to follow when installing NetWorker software:

1. Review “Installation requirements” on page 34 and note the default directory 
location.

2. Install the required NetWorker software by following one of these procedures:

• “Installing a NetWorker virtual server” on page 36

• “Installing a virtual NetWorker Console server” on page 43

• “Installing only the NetWorker client software in a cluster” on page 45

3. Enable and register all of the NetWorker products. Chapter 10, ”Licensing and 
Enabling the Software” provides detailed information.

Installation requirements
This section specifies the software and hardware required to install and configure the 
NetWorker server or client software within an AutoStart cluster environment.

The EMC Information Protection Software Compatibility Guide provides the most 
up-to-date information about software and hardware requirements.

Software requirements

The following software must be installed on each node in the cluster:

◆ AIX release 5.1 or later

◆ HP-UX release 11.x

◆ Red Hat Enterprise Linux AS2

◆ Solaris version 2.7 or later

◆ FullTime AutoStart release 5.1 or later

◆ NetWorker release 7.3

Note: Ensure that the most recent cluster patch for the operating system is installed.
FullTime AutoStart is supported on the Linux for the Intel x86 platform. It is not supported on 
other NetWorker Linux platforms.

Hardware requirements 
The following hardware requirements must be met for server installation only:

◆ Dedicated shared disk that is used as the NetWorker storage disk (for the /nsr 
directory) is connected to all the nodes within the cluster.

◆ Device with local affinity for the local bootstrap backup is connected to all the 
nodes within the cluster.
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Configuration options

The EMC NetWorker Administration Guide provides information on how to configure:

◆ Tape libraries with a NetWorker virtual server.

◆ Remote physical storage node with a NetWorker virtual server.

System information requirements

Figure 2 on page 35 illustrates a sample cluster configuration and Table 2 on page 35 
displays the system information needed to install NetWorker software within an 
AutoStart environment.

Different operating systems use different terms for the same cluster concepts. 
AutoStart refers to:

◆ Physical hosts as nodes

◆ Virtual server as a resource group (application service)

Figure 2 Sample cluster configuration

Local
Disk 1

Shared Disks 3

Node B
clus_phys2

Node A
clus_phys1

Local
Disk 2

Public Network

NetWorker Virtual Server

(If Node A fails, 
clus_vir1 fails 

over to Node B)

Table 2 Required system information (1 of 2)

Information required Example

NetWorker virtual hostname with an IP address clus_vir1
192.168.1.10

NetWorker package mount point for virtual volume /nsr_shared_mnt_pt
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Installing a NetWorker virtual server
Use this roadmap to install and configure the NetWorker software as a highly 
available service in a cluster:

◆ “Task 1: Ensure that the AutoStart software is installed” on page 36

◆ “Task 2: Install the NetWorker software in a cluster” on page 37

◆ “Task 3: Define the NetWorker server as highly available” on page 37

◆ “Task 4: Grant access to the NetWorker virtual server” on page 40

◆ “Task 5: Configure the NetWorker server” on page 41

◆ “Task 6: Configure clients under the NetWorker virtual server” on page 41

◆ “Task 7: Register NetWorker licenses for virtual server failover” on page 42

Task 1: Ensure that the AutoStart software is installed

Ensure that the AutoStart software is installed.

For AutoStart Release 5.1.2, install this patch: ftp.legato.com/pub/cluster/patches/5.1/unix

Shared storage disk virtual volume • AIX: /dev/lv1
• HP-UX: /dev/dsk/c5t2d0, /dev/vg03/1vol1 (for Logical 

Volume Manager)
• Linux: /dev/sdc1
• Solaris: /dev/dsk/c1t3d0s0

NetWorker control script • AIX: /usr/bin/nw_ux.lc
• HP-UX: /opt/networker/bin/nw_ux.lc
• Linux: /usr/sbin/nsr/nw_ux.lc
• Solaris: /usr/sbin/nw_ux.lc

File containing the hostids of all the cluster 
members

• AIX: /nsr/res/hostids
• HP-UX: /nsr/res/hostids
• Linux: /nsr/res/hostids
• Solaris: /nsr/res/hostids

NetWorker monitor script • AIX: /usr/bin/nw_ux.lc
• HP-UX: /opt/networker/bin/nw_ux.lc
• Linux: /usr/sbin/nsr/nw_ux.lc
• Solaris: /usr/sbin/nw_ux.lc

NetWorker Console virtual hostname • Linux: clus_vir2 192.168.1.11
• Solaris: clus_vir2 192.168.1.11

NetWorker Console database mount point • Linux: nmc_shared_mnt_pt
• Solaris: nmc_shared_mnt_pt

Table 2 Required system information (2 of 2)

Information required Example
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Task 2: Install the NetWorker software in a cluster

To install the NetWorker software:

1. Ensure that the most recent cluster patch for the operating system is installed.

2. Install these NetWorker software packages on each node in the cluster:

a. Client

b. Storage Node

c. Server

d. Man pages

The NetWorker Installation Guide details the installation instructions.

Task 3: Define the NetWorker server as highly available

To define and configure the NetWorker server as highly available:

1. Log in as root.

2. Ensure that the /etc/hosts file on each cluster node contains the name of the 
virtual host. The virtual hostname can be published in the Domain Name System 
(DNS) or Network Information Services (NIS).

3. Set and export the FT_DIR, FT_DOMAIN, and the FT_CONSOLE_DIR environment 
variables. 

Table 3 on page 37 lists the environmental variables that you would type from the 
Bourne shell:

Table 3 NetWorker server high availability environment variables

Operating 
System Command Variable description

AIX FT_DIR=/usr/lpp/LGTOaam51

FT_CONSOLE_DIR=$FT_DIR/console 

FT_DOMAIN=domain_name
export FT_DIR FT_DOMAIN 
FT_CONSOLE_DIR

domain_name is the AutoStart domain

HP-UX FT_DIR=/opt/LGTOaamxx
FT_CONSOLE_DIR=$FT_DIR/console

FT_DOMAIN=domain_name
export FT_DIR FT_DOMAIN 
FT_CONSOLE_DIR

• xx is set to 50 for AutoStart version 5.x
• domain_name is the AutoStart 

domain name

Linux FT_DIR=/opt/LGTOaamxx
FT_CONSOLE_DIR=$FT_DIR/console

FT_DOMAIN=domain_name
export FT_DIR FT_DOMAIN 
FT_CONSOLE_DIR

• xx is set to 50 for AutoStart version 5.x
• domain_name is the AutoStart 

domain name

Solaris FT_DIR=/opt/LGTOaamxx
FT_CONSOLE_DIR=$FT_DIR/console

FT_DOMAIN=domain_name
export FT_DIR FT_DOMAIN 
FT_CONSOLE_DIR

• xx is set to 50 for AutoStart version 5.x 
or 51 for AutoStart version 5.1

• domain_name is the AutoStart 
domain name
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4. Perform the following from each node in the cluster that will run the NetWorker 
server process:

a. Run the cluster configuration script, networker.cluster, from the appropriate 
operating system directory. Table 4 on page 38 provides details:

b. Type this information:

– Location of the local NetWorker database directory provided during the 
installation procedure:
/nsr

– Published virtual hostname:
clus_vir1

– Shared nsr mount directory:
/nsr_shared_mnt_pt

Note: Any configuration errors can be undone by running the networker.cluster -r 
option.

5. From one node in the cluster:

a. Log in as administrator.

b. Customize the necessary file from the appropriate operating system directory. 

Table 5 on page 38 provides details. This file can be used to create the NetWorker 
resource group and its dependant objects.

Note: In the file, there are multiple instances of the NW Customize comment, ensure that 
all entries are replaced with the appropriate cluster configuration values. 

c. Follow the instructions in the comments at the beginning of the file to 
customize the default values listed in Table 6 on page 39 based on the cluster 
configuration.

Table 4 Operating system directory for networker.cluster script

Operating system Directory

AIX  /usr/bin/

HP-UX /opt/networker/bin/

Linux /usr/sbin/

Solaris  /usr/sbin/

Table 5 Operating system directory for cluster configuration files

Operating system Directory

AIX  /usr/bin/nw_ux.lc.imp

HP-UX  /opt/networker/bin/nw_ux.lc.aam5.imp

Linux  /opt/lgtonmc/bin/nw_ux.lc.aam5.imp

Solaris /opt/LGTOnmc/bin/nw_ux.lc.aam5.imp
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d. Type the appropriate command from Table 7 on page 39.

e. Use the AutoStart Management Console to verify that the NetWorker resource 
group was imported correctly.

f. Run the appropriate script from Table 8 on page 39.

Table 6 Cluster configuration default values

Operating 
system Filename Environmental variable Value

AIX /usr/bin/nw_ux.lc.imp Virtual host’s IP address:
Physical hostnames:
Shared disk file system:
Device name:

192.168.1.10
clus_phys1, clus_phys2
/nsr_shared_mnt_pt
/dev/1v1

HP-UX /opt/networker/bin/nw_ux.lc.aam5.imp Virtual host’s IP address:
Physical hostnames:
Shared disk file system: 

192.168.1.10
clus_phys1, clus_phys2
/dev/vg03/lvol1, /vg_nsr hfs

Linux /opt/lgtonmc/bin/nw_ux.lc.aam5.imp Virtual host’s IP address:
Physical hostnames:
Shared disk file system:
Device name:

192.168.1.10
clus_phys1, clus_phys2
/nsr_shared_mnt_pt
/dev/dsk/c1t3d0s0

Solaris /opt/LGTOnmc/bin/nw_ux.lc.aam5.imp Virtual host’s IP address:
Physical hostnames:
Shared disk file system:
Device name:

192.168.1.10
clus_phys1, clus_phys2
/nsr_shared_mnt_pt
/dev/dsk/c1t3d0s0

Table 7 NetWorker server commands

Operating System Command

AIX $FT_DIR/bin/ftcli -c 
“import/usr/bin/nw_ux.lc.aam5.imp”

HP-UX $FT_DIR/bin/ftcli -c “import 
/opt/lgtonmc/bin/nw_ux.lc.aam5.imp”

Note: If the LVM software is being used, the AutoStart application requires two data 
sources—one to activate the volume group (/dev/vg03) and one to mount the shared 
mount point (/vg_nsr on /dev/vg03/lvol1).

Linux $FT_DIR/bin/ftcli -c “import 
/usr/sbin/nsr/nw_ux.lc.aam5.imp”

Solaris $FT_DIR/bin/ftcli -c “import 
/opt/LGTOnmc/bin/nw_ux.lc.aam5.imp”

Table 8 NetWorker server scripts

Operating System Script

AIX /usr/bin/nwinst.sh

HP-UX /opt/networker/bin/nwinst.s
h
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Task 4: Grant access to the NetWorker virtual server

Before a NetWorker server can back up a client, the server must have access to the 
client. Access is granted by editing the /nsr/res/servers file.

Note: If the /nsr/res/servers file is empty or does not exist, any NetWorker server is 
authorized to:
- Access and back up the client.
- Perform a directed recovery to the client.

To grant access to the NetWorker virtual server:

1. On each node in the cluster:

a. Shut down the NetWorker services.

b. Edit or create the /nsr.Networker.local/res/servers file:

– Add the set of NetWorker servers, one per line, that require access to this 
client.

– For each virtual NetWorker server, add an entry for each physical host and 
the virtual NetWorker server. For example:
clus_vir1

clus_phys1

clus_phys2

c. Check the NetWorker boot-time startup file to see whether nsrexecd is being 
run with the -s option. If the -s option exists, remove all occurrences of the 
following in the file:

-s server_name

2. On one node in the cluster, start the NetWorker service by using the cluster 
management software:

a. Use the AutoStart Management Console to bring the NetWorker Resource 
Group online.

b. Edit or create the /nsr/res/servers file:

– Add the set of NetWorker servers, one per line, that require access to this 
client.

– For each virtual NetWorker server, add an entry for each physical host and 
the virtual NetWorker server. For example:
clus_vir1

clus_phys1

clus_phys2

Linux /usr/bin/nwinst.sh

Solaris /usr/sbin/nwinst.sh

Table 8 NetWorker server scripts

Operating System Script
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3. If required, grant access to each NetWorker client that is outside of the cluster:

a. Shut down the NetWorker processes and verify that all NetWorker services 
have stopped.

b. Edit or create the /nsr/res/servers file:

– Add the set of NetWorker servers, one per line, that require access to this 
client.

– For each virtual NetWorker server, add an entry for each physical host and 
the virtual NetWorker server. For example:
clus_vir1

clus_phys1

clus_phys2

Task 5: Configure the NetWorker server

To configure the NetWorker server:

1. Log in as root on the cluster node that is currently running the NetWorker server 
resource group.

2. Start the NetWorker Console software.

3. From the Administration window, select File>Properties.

a. For the Administrator attribute, add entries for any cluster nodes that are not 
already listed. For example:

root@hostname

b. Click OK.

Task 6: Configure clients under the NetWorker virtual server

When the networker.cluster script runs, it creates a symbolic link named /nsr that 
points to a local disk. It also creates a second link points to the local NetWorker 
directory. For example, if the local NetWorker directory was created in /var/nsr, 
each client member has these links:

◆ AIX, HP-UX, Solaris

• /nsr->/nsr.NetWorker.local

• /nsr.NetWorker.local->/var/nsr

◆ Linux

• /nsr->/nsr.NetWorkerBackup.local

• /nsr.NetWorkerBackup.local->/var/nsr

To configure each client under the NetWorker server:

1. (Optional) Define savegroups.

Note: In order for their save sets to restart after a virtual client or NetWorker server 
failover savegroups must have the Autorestart attribute enabled and the Manual Restart 
option disabled.
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2. Make each physical client within the cluster a client of the NetWorker virtual 
server. For each physical client in the cluster:

a. Create a new NetWorker client.

b. For the Name attribute, type the name of the physical client.

3. Make each virtual client within the cluster a client of the NetWorker virtual 
server. For each virtual client in the cluster:

a. Create a new NetWorker client.

b. For the Name attribute, type the name of the virtual client.

c. For the Remote Access attribute, add entries for each physical client within 
the cluster. For example:

root@clus_phys1

d. For the Group attribute, select a group.

The first time the NetWorker application runs, it creates the Client resource for 
the NetWorker virtual server. The EMC NetWorker Administration Guide provides 
more more information.

4. For AIX only, on each node that the logical volume can be attached, check that the 
/etc/filesystems file contains the same mount point for the logical volume as the 
one specified in the FullTime AutoStart Resource group. 

To change the entry for the logical volume mount point in the /etc/filesystems 
file, type:

chfs -n new_mountpoint old_mountpoint

5. Run a test probe to verify that the Client and Group resources have been 
properly configured.

Type the following command on the node on which the NetWorker server 
resides:

savegrp -pv -c client_name group_name

The EMC NetWorker Administration Guide provides information on how to 
troubleshoot if the test probe does not display the correct scheduled backups and 
index.

Task 7: Register NetWorker licenses for virtual server failover
To register a NetWorker server in a cluster environment:

1. Ensure that the NetWorker virtual server is defined as a part of the cluster.

2. Ensure that the NetWorker service is running.

3. For each physical node in the cluster:

a. Relocate, sequentially, the NetWorker server to this node.

b. From the NetWorker Administration window, note the host ID number for 
the appropriate cluster license.
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4. Log in to the system that is running the NetWorker virtual server and create the 
/nsr/res/hostids file. This file contains the host IDs of all the cluster nodes. 

Use this syntax:

hostid1:hostid2:hostid3:... 

For example:

12345678:87654321

5. Restart the server by taking the NetWorker virtual server offline and then putting 
it back online.

6. From the NetWorker Administration window, note the host ID number for the 
appropriate cluster license.

7. Register the NetWorker software.

Installing a virtual NetWorker Console server
To install and configure the NetWorker Console software as a highly available 
service in a cluster, read and follow the procedures for these tasks:

◆ “Task 1: Install the NetWorker Management software in a cluster” on page 43

◆ “Task 2: Define the NetWorker Console server as highly available” on page 43

Note: A highly available NetWorker Console Server in only supported on the Linux and 
Solaris platforms.

Task 1: Install the NetWorker Management software in a cluster

To install the NetWorker software on each node in the cluster:

1. Ensure that the most recent cluster patch for the operating system is installed.

2. Ensure that the $HOME environment variable is set to the home directory of the 
root user:

$HOME

3. Install the NetWorker Console server software on each node in the cluster.

• Linux: lgtonmc

• Solaris: LGTOnmc

The NetWorker Installation Guide provides detailed installation instructions.

Task 2: Define the NetWorker Console server as highly available

To define and configure the NetWorker Console server as a highly available 
application on each node in the cluster:

1. Log in as root.

2. Ensure that the /etc/hosts file on each cluster node contains the name of the 
virtual host. The virtual hostname can be published in the Domain Name System 
(DNS) or Network Information Service (NIS).
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3. Set and export the FT_DIR, FT_DOMAIN and the FT_CONSOLE_DIR 
environment variables. For example, from the Bourne shell type these commands:

FT_DIR=/opt/LGTOaamxx
FT_CONSOLE_DIR=$FT_DIR/console
FT_DOMAIN=domain_name
export FT_DIR FT_DOMAIN FT_CONSOLE_DIR

where:

• xx is set to 5.0 for AutoStart version 5.0 or 5.1 for version 5.1

• domain_name is set to AutoStart domain

4. From each node in the cluster that will run the NetWorker Console server 
process:

a. Run the appropriate cluster configuration script as listed in Table 9 on 
page 44:

b. Type this information:

– Published logical hostname: clus_vir1
– Shared nmc mount directory: /nmc_shared_mnt_pt

Note: Any changes to the configuration can be undone by running the gst_ha.cluster -r 
option.

5. From one node in the cluster, customize the appropriate file listed in Table 10 on 
page 44.

This file is used to create the NetWorker Console resource group and its 
dependant objects in one step.

Note: In the gst_ha_ux.aam5.imp file, there are multiple instances of the “NW Customize” 
comment. Ensure that all entries are replaced with the appropriate cluster configuration 
values. 

Follow the instructions listed in the comments at the beginning of the 
gst_ha_ux.aam5.imp file to customize these NetWorker Console default values 
based on the cluster configuration: 

• Virtual host’s IP address: 192.168.1.10

• Physical hostnames: clus_phys1, clus_phys2

Table 9 Cluster configuration scripts

Under this operating system Run this script

Linux /opt/lgtonmc/bin/gst_ha.cluster

Solaris /opt/LGTOnmc/bin/gst_ha.cluster

Table 10 Cluster file customization

Under this operating system Customize this file

Linux /opt/lgtonmc/bin/gst_ha_ux.aam5.imp

Solaris /opt/LGTOnmc/bin/gst_ha_ux.aam5.imp
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• Shared disk file system: /nmc_shared_mnt_pt

• Device name: /dev/dsk/c1t3d0s0

Table 2 on page 35 lists the sample values.

6. Type the appropriate command from Table 11 on page 45. The NetWorker 
Console resource group is automatically created. 

7. Verify that the NetWorker Console resource group was imported by using the 
FullTime AutoStart Console.

Installing only the NetWorker client software in a cluster
Complete these tasks to install NetWorker cluster client:

◆ “Task 1: Install the NetWorker cluster client software” on page 45

◆ “Task 2: Configure the NetWorker client software as highly available” on page 45

◆ “Task 3: Define the list of trusted NetWorker servers” on page 46

◆ “Task 4: Configure clients under the NetWorker server” on page 47

Note: Install the NetWorker client software on every node in the cluster to be backed up.

Task 1: Install the NetWorker cluster client software

To install the NetWorker client software on each node in the cluster:

1. Ensure that the operating system is updated with the most recent cluster patch.

2. Install the NetWorker client software on every node in the cluster to be backed 
up.

Task 2: Configure the NetWorker client software as highly available

To define and configure a NetWorker client as highly available:

1. Log in as root on each node where the NetWorker software was installed.

2. Ensure that the /etc/hosts file on each cluster node contains the name of the 
virtual host. The virtual hostname can be published in a the Domain Name 
System (DNS) or the Network Information Service (NIS).

3. Set and export the FT_DIR, FT_DOMAIN and the FT_CONSOLE_DIR 
environment variables. Table 3 on page 37 lists the environmental variables that 
you would type from the Bourne shell

Table 11 Cluster configuration scripts

Under this operating system Run this script

Linux $FT_DIR/bin/ftcli -c “import /opt/lgtonmc/bin/gst_ha_ux.aam5.imp

Solaris $FT_DIR/bin/ftcli -c “import 
/opt/LGTOnmc/bin/gst_ha_ux.aam5.imp”
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4. For each node in the cluster:

a. Run the networker.cluster configuration script, located as indicated in 
Table 12 on page 46. 

b. When prompted to configure the NetWorker server, type No.

Note: Any configuration errors can be undone by running the networker.cluster -r option. 

Task 3: Define the list of trusted NetWorker servers
Before a NetWorker server can back up a client, the client must grant the server 
access. Access is granted by editing the /nsr/res/servers file.

Note: If the /nsr/res/servers file is empty or does not exist, any NetWorker server is 
authorized to: 
- Access and back up the client.
- Perform a directed recovery to the client.

To define the list of trusted NetWorker servers, perform the following steps on each 
node in the cluster:

1. Shut down the NetWorker processes and verify that all NetWorker services have 
stopped.

2. Edit or create the /nsr/res/servers file:

a. Add the set of NetWorker servers, one per line, that require access to this 
client.

b. For each virtual NetWorker server, add an entry for each physical host and the 
virtual NetWorker server. For example:

– clus_vir1
– clus_phys1
– clus_phys2

3. Check the NetWorker boot-time startup file to see whether nsrexecd is being run 
with the -s option. 

If the -s option exists, remove all occurrences of the following:

-s server_name

Table 12 Cluster configuration scripts

Under this operating system Run this cluster configuration script

AIX /usrbin/ 

HP-UX /opt/networker/bin/ 

Linux /usr/sbin/

Solaris /usr/sbin/ 
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Task 4: Configure clients under the NetWorker server

To configure each client under the NetWorker server:

1. Make each physical client within the cluster a client of the NetWorker server. For 
each physical client in the cluster:

a. Create a new NetWorker client.

b. For the Name attribute, type the name of the physical client.

Note: If a physical Client is backed up to a NetWorker server outside the cluster, the name 
of any virtual service that can run on the physical node must be added to the Remote 
Access list of the physical Client property sheet.

2. Make each virtual client within the cluster a client of the NetWorker virtual 
server. For each virtual client in the cluster:

a. Create a new client.

b. For the Name attribute, type the name of the virtual client.

c. For the Remote Access attribute, add entries for each physical client within 
the cluster. For example:

root@clus_phys1

d. For the Group attribute, select a group.

3. Schedule backups by using the NetWorker software.

Note: The NetWorker server might reside outside of the cluster. 

Uninstalling the NetWorker software
To uninstall the NetWorker software from a cluster environment: 

1. If necessary, use the cluster management software to stop services on the 
NetWorker server.

2. Shut down the client services on the node where the NetWorker software is being 
removed:

nsr_shutdown

A list of NetWorker services appears.

3. Ensure that these environment variables are set:

• $FT_DIR

• $FT_DOMAIN 

4. Run the appropriate command as indicated in Table 13 on page 47.

Table 13 Cluster configuration scripts

Under this operating system Run this cluster configuration script

AIX /usr/bin/networker.cluster -r
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5. Complete one of these procedures to remove the existing version of NetWorker 
software:

• “AIX Version” on page 48

• “HP-UX version” on page 48

• “Linux version” on page 49

• “Solaris version” on page 49

AIX Version

To uninstall individual NetWorker software packages or all of the NetWorker 
packages at the same time, use the SMIT utility:

1. Log in as root on the computer where the software is being removed.

2. Type this command to remove the NetWorker software:

smitty remove

3. Select F4=List to display a list of NetWorker software packages.

4. Select the NetWorker software packages to remove, as indicated in Table 14 on 
page 48:

5. Press Return to uninstall the NetWorker software.

HP-UX version
To uninstall individual NetWorker software packages or all of the NetWorker 
packages simultaneously:

1. To check which NetWorker packages have been installed, type:

swlist | grep LGTO

2. Remove the existing version of NetWorker software.

HP-UX /opt/networker/bin/networker.cluster -r

Linux /usr/sbin/networker.cluster -r

Solaris /usr/sbin/networker.cluster -r

Table 13 Cluster configuration scripts

Under this operating system Run this cluster configuration script

Table 14 Removing NetWorker software packages

For this NetWorker software package Remove this file

Client software LGTOnw.clnt.rte

Storage node LGTOnw.node.rte

Server LGTOnw.serv.rte

Man pages LGTOnw.man.rte 

NetWorker License Manager LGTOnw.licm.rte
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Linux version

To uninstall a single NetWorker software package or all of the NetWorker packages 
simultaneously, type:

rpm -e lgtoman-x.x.x lgtolicm-x.x.x lgtoserv-x.x.x lgtonode-x.x.x 
lgtoclnt-x.x.x 

where x.x.x identifies the specific NetWorker release

Solaris version

To uninstall a single NetWorker software package or all of the NetWorker packages 
simultaneously, type:

pkgrm LGTOman LGTOserv LGTOnode LGTOnmc LGTOlicm LGTOclnt

Configuring an external client to back up to a virtual server
Use this procedure to configure and back up an external client to a NetWorker virtual 
server.

Before a NetWorker server can back up a client, the client must grant the server 
access. Access is granted by editing the /nsr/res/servers file.

Note: If the /nsr/res/servers file is empty or does not exist, any NetWorker server is 
authorized to:
- Access and back up the client.
- Perform a directed recovery to the client.

On each NetWorker client that is outside of the cluster:

1. Shut down the NetWorker processes and verify that all NetWorker services have 
stopped.

2. Edit or create the /nsr/res/servers file:

a. Add the set of NetWorker servers, one per line, that require access to this 
client.

b. For each virtual NetWorker server, add an entry for each physical host and the 
virtual NetWorker server. For example:

– clus_vir1
– clus_phys1
– clus_phys2

Defining ownership of a raw partition for virtual clients
To back up the raw partitions of a NetWorker virtual client, use the IPOverride 
option in the AutoStart Management Console:

1. Open the AutoStart Console and select Resource Group. The Resource Group 
Editor window appears.

2. Select Edit View and then select Attributes from the Edit menu. The Define 
Resource Group Attributes dialog box appears.
Configuring an external client to back up to a virtual server 49



EMC AutoStart for UNIX Installation
3. Add the following line in the Define Resource Group Attributes window: 

IPOverride=IP_address=raw_partition_path

For example: IPOverride=135.69.103.149=/dev/rdsk/c1t3d0s1

Note: The IPOverride attribute does not add to the normal list of virtual client-owned paths, 
but completely overrides them. In the previous example, if the virtual client also owns the 
/share/web filesystem, set this path:

IPOverrride=135.69.103.149=/dev/rdsk/c1t3d0s1, /share/web
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Software installation roadmap
Use the following roadmap to follow when installing NetWorker software:

1. Review “Installation requirements” on page 52 and note the default directory 
locations.

2. Install the required NetWorker software by following one of these procedures:

• “Installing a NetWorker virtual server” on page 54

• “Installing only the NetWorker client software in a cluster” on page 59

3. Enable and register all of the NetWorker products. Chapter 10, ”Licensing and 
Enabling the Software,” provides detailed information.

Installation requirements
This section specifies the software and hardware required to install and configure the 
NetWorker server or client software within an HACMP for AIX environment.

The EMC Information Protection Software Compatibility Guide provides the most 
up-to-date information about software and hardware requirements.

Software requirements
The following software must be installed on each node in the cluster:

◆ AIX release 4.3.x or later

◆ HACMP for AIX release 4.5 or later (this requires a persistent IP address for each 
physical node)

◆ NetWorker release 7.0 or later

Hardware requirements

The following hardware requirements must be met:

◆ A dedicated shared volume group and file system used as the NetWorker storage 
area (for the /nsr directory) must be connected to all the nodes within the cluster 
(for server installation only).

◆ A device with local affinity for the local bootstrap backup connected to all the 
nodes within the cluster (for server installation only).

◆ For clusters configured with IP address takeover (IPAT), must be connect to a 
computer through its boot address if a resource group is not defined. Service 
addresses are associated with a resource group, not physical nodes. 

The output of the hostname command on a machine must correspond to an IP 
address that can be pinged. The machine hostname must also be set to the name 
equivalent to the address that is used by the physical client’s dedicated NIC. 
Configure this NIC as the primary network adapter, for example, en0. An extra 
NIC outside of the control of HACMP for AIX is not required to enable a highly 
available NetWorker server.
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Configuration options

The EMC NetWorker Administration Guide provides details about the following 
optional configurations:

◆ Tape libraries with a NetWorker virtual server

◆ Remote physical storage nodes with a NetWorker virtual server

System information requirements

Figure 3 on page 54 illustrates a sample cluster configuration and Table 15 on page 53 
displays the system information needed to install NetWorker software within an 
HACMP for AIX cluster environment.

These terms are used to define HACMP for AIX cluster concepts: 

◆ Node name — The HACMP for AIX defined name for a physical node. 

◆ Boot address — The address used by a node when it boots up, but before 
HACMP for AIX starts.

◆ Service address — The address used by highly available services in an HACMP 
for AIX environment.

◆ Virtual client — The client associated with a highly available resource group. The 
file system defined in a resource group belongs to a virtual client. The virtual 
client uses the service address.

The HACMP for AIX resource group must contain an IP service label to be 
considered a NetWorker virtual client.

◆ Physical client — The client associated with a physical node. For example the / 
and /usr file systems belong to the physical client.

◆ Physical host address (physical hostname) — The address used by the physical 
client. For HACMP for AIX 4.5, this is equivalent to a persistent IP address.

Table 15 Required cluster information

Required information Example

NetWorker virtual name with an IP addresses clus_vir1, 191.168.1.10

Physical address for Node 1 191.168.1.20

Physical address for Node 2 191.168.1.30

NetWorker package mount point for virtual volume /nsr_shared_mnt_pt

NetWorker control script /usr/bin/nw_hacmp.lc

File containing the hostids of all the cluster members /nsr/res/hostids
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Figure 3 Sample cluster configuration with private network

Installing a NetWorker virtual server
Use this roadmap to install and configure the NetWorker software as a highly available 
service in an HACMP for AIX environment:

◆ “Task 1: Install the NetWorker software in a cluster” on page 54

◆ “Task 2: Define the server as highly available” on page 55

◆ “Task 3: Define an HACMP for AIX NetWorker server” on page 55

◆ “Task 4: Grant access to the NetWorker virtual server” on page 56

◆ “Task 5: Configure the NetWorker cluster server” on page 57

◆ “Task 6: Configure clients under the NetWorker cluster server” on page 57

◆ “Task 7: Register NetWorker licenses for virtual server failover” on page 58

Task 1: Install the NetWorker software in a cluster
To install the NetWorker software in a cluster:

1. Ensure that the most recent HACMP for AIX patch is installed.

2. Install these NetWorker software packages on each node in the cluster:

• Client

• Storage node

• Server

The NetWorker Installation Guide provides installation instructions.

Local
Disk 1

Cluster

Shared Disks 3

Node 2
node name: right

physical host: node_2

Node 1
node name: left

physical host: node_1

Local
Disk 2

Public Network

NetWorker Virtual Server
Service Address: clus_vir1

(If Node 1 fails, 
clus_vir1 fails 

over to Node 2)

Private Network
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Task 2: Define the server as highly available

To define and configure the NetWorker server as highly available:

1. Log in as root.

2. Ensure that the /etc/hosts file on each cluster node contains the name of the virtual host. 
The virtual hostname in the DNS or NIS can be published.

3. From each node in the cluster that will run the NetWorker server process:

a. Run the cluster configuration script, networker.cluster, located in the /usr/bin/ 
directory.

b. Type the following information:

– Location of the local NetWorker database directory provided during the 
installation procedure:
/nsr

– Published virtual hostname:
clus_vir1

– Shared nsr mount directory:
/nsr_shared_mnt_pt

Note: Any configuration can be undone by running the networker.cluster -r option.

4. Verify that these values are set:

NSR_SERVERHOST = virtual hostname (clus_vir1)

NSR_SHARED_DISK_DIR = shared nsr mount directory (/nsr_shared_mnt_pt)

Task 3: Define an HACMP for AIX NetWorker server 

To define an HACMP for AIX NetWorker server:

1. Create a shared file system.

2. Define a service IP label.

3. Define a NetWorker application service:

a. Type this command as root:

smit hacmp

b. From the main window, select these options: 

Cluster Configuration>Cluster Resource>Define Application Server>Add an 
Application Server

c. Complete the following as shown:

Server name: networker

Start script: /usr/bin/nw_hacmp.lc start

Stop script: /usr/bin/nw_hacmp.lc stop

This application server will be used by the NetWorker resource group.

4. Configure a NetWorker resource group.

The HACMP for AIX documentation provides instructions on defining and monitoring a 
resource group in an HACMP for AIX environment.
Installing a NetWorker virtual server 55



HACMP for AIX Installation
Task 4: Grant access to the NetWorker virtual server

Before a NetWorker server can back up a client, the server must have access to the 
client. Granting access to the server is controlled by editing the /nsr/res/servers file. 

If the /nsr/res/servers file is empty or does not exist, any NetWorker server can back 
up a client. Only servers listed in the /nsr/res/servers file can back up a client.

To grant access to the NetWorker virtual server:

1. Perform the following on each node in the cluster:

a. Shut down the NetWorker processes and verify that all NetWorker daemons 
have stopped.

b. Edit or create the /nsr.NetWorker.local/res/servers file:

– Add the set of NetWorker servers, one per line, that require access to this 
client.

– For each virtual NetWorker server, add an entry for each physical host and 
the NetWorker virtual server. For example:
clus_vir1

clus_phys1

clus_phys2

c. Check the NetWorker boot-time startup file to see whether nsrexecd is being 
run with the -s option. If the -s option exists, remove all occurrences of the 
following in the file:

-s server_name

2. Perform the following on one node in the cluster, start the NetWorker service by 
using the cluster management software:

a. Use the HACMP for AIX software to bring the NetWorker resource group 
online.

b. Edit or create the /nsr/res/servers file:

– Add the set of NetWorker servers, one per line, that require access to the 
client.

– For each virtual NetWorker server, add an entry for each physical host and 
the virtual NetWorker server. For example:
clus_vir1

clus_phys1

clus_phys2

3. If required, grant access to each NetWorker client that is outside of the cluster:

a. Shut down the NetWorker processes and verify that all NetWorker daemons 
have stopped:

nsr_shutdown

ps -ef | grep nsr

b. Edit or create the /nsr/res/servers file:

– Add the set of NetWorker servers, one per line, that require access to the 
client.
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– For each virtual NetWorker server, add an entry for each physical host and 
the virtual NetWorker server. For example:
clus_vir1

clus_phys1

clus_phys2

Task 5: Configure the NetWorker cluster server

To configure the NetWorker server:

1. Log in as root on the cluster node that is running the NetWorker virtual server.

2. Start the NetWorker Console software.

a. From the Console window, click Enterprise.

b. From the left pane, select the Enterprise icon.

The NetWorker server appears in the right and left panes.

c. From the left pane, select the NetWorker server.

d. From the right pane, select the NetWorker application.

e. From the Enterprise menu, select Launch Application. 

The Administration window launches. 

3. From the Administration window, click Configuration.

a. In the left pane, select the NetWorker server. 

b. From the File menu, select Properties. The Properties dialog box appears.

– For the Administrator attribute, add entries for any cluster nodes that are 
not already listed. For example:
root@hostname

– Click OK.

Task 6: Configure clients under the NetWorker cluster server
When the networker.cluster script runs, it creates a symbolic link named /nsr that 
points to a local disk. It also creates a second link named nsr.NetWorker.local that 
points to the local NetWorker directory. For example, if the local NetWorker 
directory was created in /var/nsr, each client member has these links:

◆ /nsr->/nsr.NetWorker.local

◆ /nsr.NetWorker.local->/var/nsr

To configure clients under the NetWorker cluster server:

1. (Optional) Define savegroups.

Note: In order for their save sets to restart after a virtual client or NetWorker server 
failover, savegroups must have the Autorestart attribute enabled and the Manual Restart 
option disabled.
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2. Make each physical client within the cluster a client of the NetWorker server. For 
each physical client in the cluster:

a. Create a new NetWorker client.

b. Type the name of the physical client for the Name attribute.

c. Add the boot adaptor name in the Aliases list. 

3. Make each virtual client within the cluster a client of the virtual NetWorker 
server. For each virtual client in the cluster:

a. Create a new client.

b. Type the name of the service address for the Name attribute.

c. For the Remote Access attribute, the user must be the root user for the boot 
address. 

d. Add entries for each service, boot, and physical address defined within the 
cluster. For example:

root@clus_phys1

e. For the Group attribute, select a group.

4. Run a test probe to verify that the Client and Group resources have been 
properly configured.

On the node on which the NetWorker server resides, type:

savegrp -pv -c client_name group_name

5. If the test probe does not display the scheduled backups and index, see “Tracking 
scheduled saves” on page 62.

Task 7: Register NetWorker licenses for virtual server failover
To register a NetWorker server in a cluster environment:

1. Ensure that the NetWorker virtual server is defined as a part of the cluster.

2. Ensure that the NetWorker service is running.

3. For each physical node in the cluster:

a. Relocate, sequentially, the NetWorker server to this node.

b. From the NetWorker Administration window, note the host ID number for 
the appropriate cluster license.

4. Log in to the system that is running the NetWorker virtual server and create the 
/nsr/res/hostids file. This file contains the host IDs of all the cluster nodes. 

Use this syntax:

hostid1:hostid2:hostid3:... 

For example:

12345678:87654321

5. Restart the server by taking the NetWorker virtual server offline and then putting 
it back online.

6. From the NetWorker Administration window, note the host ID number for the 
appropriate cluster license.

7. Register the NetWorker software. 
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Installing only the NetWorker client software in a cluster
Use this roadmap to install a NetWorker cluster client:

◆ “Task 1: Install the NetWorker cluster client software” on page 59

◆ “Task 2: Configure the NetWorker client software as highly available” on page 59

◆ “Task 3: Define the list of trusted NetWorker servers” on page 59

◆ “Task 4: Configure clients under the NetWorker server” on page 60

Note: Ensure that the NetWorker client software is installed on every node in the cluster that 
needs to be backed up.

Task 1: Install the NetWorker cluster client software
To install the NetWorker client software on each node in the cluster:

1. Ensure that the most recent HACMP for AIX patch is installed.

2. Install the NetWorker client software on every node in the cluster to be backed 
up. 

The NetWorker Installation Guide provides detailed installation instructions.

Task 2: Configure the NetWorker client software as highly available

To define and configure a NetWorker client as highly available:

1. Log in as root on each node where the NetWorker software is being installed.

2. Ensure that the /etc/hosts file on each cluster node contains the name of the 
virtual host. The virtual hostname in a DNS or NIS can be published.

3. For each node in the cluster:

a. Run the cluster configuration script, networker.cluster.

b. When prompted to configure the NetWorker server, type No.

Note: If the configuration is not correct, any configuration can be undone by running the 
networker.cluster -r option. For an example of the script, see “Exit the SMIT program.” on 
page 61.

Task 3: Define the list of trusted NetWorker servers

Before a NetWorker server can back up a client, the client must grant the server 
access. Granting access is controlled by the /nsr/res/servers file. If this file does not 
exist, any NetWorker server can back up this client. If this file does exist, only the 
specific servers listed in it can back up the client.

To define the list of trusted NetWorker servers, perform these steps on each node in 
the cluster:

1. Shut down the NetWorker processes and verify that all NetWorker daemons 
have stopped.
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2. Edit or create the /nsr/res/servers file:

a. Add the set of NetWorker servers, one per line, that require access to this 
client.

b. For each NetWorker virtual server, add an entry for each physical host and the 
NetWorker virtual server. For example:

clus_vir1

clus_phys1

clus_phys2

3. Check the NetWorker boot-time startup file to see whether nsrexecd is being run 
with the -s option. If the -s option exists, remove all occurrences of the following 
in the file:

-s server_name

Task 4: Configure clients under the NetWorker server
To configure the NetWorker server:

1. Make each physical client within the cluster a client of the NetWorker server. 

For each physical client in the cluster:

a. Create a new client.

b. Type the name of the physical client for the Name attribute.

c. Add the boot adaptor name in the Aliases list. 

Note: If a physical Client is backed up to a NetWorker server outside the cluster, the name 
of any virtual service that can run on the physical node must be added to the Remote 
Access list of the physical Client property sheet.

2. Make each virtual client within the cluster a client of the NetWorker server.

For each virtual client in the cluster:

a. Create a new client.

b. For the Name attribute, type the name of the NetWorker server.

c. For the Remote Access attribute, add entries for each service, boot, and 
physical address defined within the cluster. For example:

root@clus_phys1

d. For the Group attribute, select a group.

3. Schedule backups by using NetWorker. 

Note: The NetWorker server might reside outside of the cluster. 
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Uninstalling the NetWorker software
To uninstall the NetWorker software from a cluster environment: 

1. If necessary, use the cluster management software to stop the NetWorker server 
services.

2. Shut down the client services on the node with the NetWorker software to be 
removed:

nsr_shutdown

A list of NetWorker services appears and prompts you to continue with the 
nsr_shutdown command.

3. Run this command:

/usr/bin/networker.cluster -r

4. Use SMIT to uninstall individual NetWorker software packages or all of the 
NetWorker packages at the same time. 

5. To uninstall the NetWorker software, log in as root on the computer where the 
software is being removed.

6. Type this command to remove the NetWorker software:

smitty remove

7. Select F4=List to display a list of NetWorker software packages.

8. Select the NetWorker software packages to remove, as indicated in Table 16 on 
page 61:

9. Press [Return] to uninstall the NetWorker software.

10. Exit the SMIT program.

Configuring an external client to a virtual server
If required, use this procedure to configure and back up an external client to a 
NetWorker virtual server.

Before a NetWorker server can back up a client, the client must grant the server 
access. Granting access is controlled by the /nsr/res/servers file. If this file does not 
exist, any NetWorker server can back up this client. If this file does exist, only the 
specific servers listed in it, can back up the client.

Table 16 Removing NetWorker software packages

For this NetWorker software package Remove this file

Client software LGTOnw.clnt.rte

Storage node LGTOnw.node.rte

Server LGTOnw.serv.rte

Man pages LGTOnw.man.rte 

NetWorker License Manager LGTOnw.licm.rte
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On each NetWorker client that is outside of the cluster:

1. Shut down the NetWorker processes and verify that all NetWorker daemons 
have stopped.

2. Edit or create the /nsr/res/servers file:

a. Add the set of NetWorker servers, one per line, that require access to this 
client.

b. For each virtual NetWorker server, add an entry for each physical host and the 
virtual NetWorker server. For example:

clus_vir1

clus_phys1

clus_phys2

Scheduling saves for raw volumes
To enable NetWorker scheduled saves of raw volumes that are owned by a resource 
group (virtual client), flag the logical volume as follows: 

1. Ensure that the volume group to which the logical volume belongs appears under 
Volume Groups in the resource group configuration.

2. Set the logical volume type to raw by using the chlv command. For example:

chlv -t 'raw' logical_volume_name

In this example, the logical volume ha_rv, that belongs to the volume group havg, 
will be used as a raw device:

chlv -t’raw’ ha_rv

lsvg -l havg

havg:

Note: The NetWorker software does not support raw volumes used for concurrent access.

Tracking scheduled saves
To verify that the Client and Group resources are properly configured, run a test 
probe for each client from the node where the NetWorker application is running:

savegrp -pv -c client_name group_name

If the test probe does not display all the scheduled save sets:

◆ Check the cluster configuration by using the cluster management software. If 
necessary, reconfigure the cluster.

◆ Ensure that the save sets defined for the client are owned by that client. If 
necessary, redistribute the client save sets to the appropriate Client resources. 

Note: Misconfiguration of the Cluster resources might cause scheduled save sets to be 
dropped from the backup. The EMC NetWorker Administration Guide provides more 
information.
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◆ Type this command to override scheduled save rules (not path ownership rules):

touch networker_bin_dir/pathownerignore

◆ Run a second test probe to verify the configuration.

This command allows any path to be backed up for a client, whether it is owned 
by the virtual client or physical node. The EMC NetWorker Administration Guide 
provides more information.

If the pathownerignore command was used, check that the NetWorker scheduled 
save uses the correct client index. If the wrong index is used, the save sets can be 
forced to go to the correct index:

1. From the NetWorker Administration window, select a client and edit its 
properties.

2. For the Backup Command attribute, type the name of a backup script that 
contains 
save -c client_name 

The EMC NetWorker Administration Guide provides details about the Backup 
Command attribute.
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Software installation roadmap
Use the following roadmap when installing the NetWorker software in an HP-UX 
MC/ServiceGuard or HP-UX MC/LockManager cluster environment. 

1. Review “Installation requirements” on page 66 and note the default directory 
location.

2. Install the required NetWorker software by following one of these procedures:

• “Installing a highly available NetWorker cluster-aware server” on page 68.

• “Installing only the NetWorker client software in a cluster” on page 73

3. Enable and register all of the NetWorker products. Chapter 10, ”Licensing and 
Enabling the Software‚" provides detailed information.

Installation requirements
This section specifies the software and hardware required for setting up NetWorker 
software as a highly available application within an HP-UX MC/ServiceGuard or 
HP-UX MC/LockManager cluster environment:

◆ “Software requirements” on page 66

◆ “Hardware requirements” on page 66

◆ “System information requirements” on page 67

The EMC Information Protection Software Compatibility Guide provides the most 
up-to-date information about software and hardware requirements.

Software requirements
The following software must be installed on each node in the cluster:

◆ HP-UX 10.20 or 11.x

◆ HP-UX MC/ServiceGuard, release 10.05 or later, HP-UX MC/ServiceGuard OPS 
Edition for HP-UX 11.x, or HP-UX MC/LockManager, release 10.06, 10.07, or 
10.07.01

◆ NetWorker release 7.4 Service Pack 1

Hardware requirements

The following hardware requirements must be met:

◆ A dedicated shared disk used as the NetWorker storage area (for the /nsr 
directory) must be connected to all the nodes within the cluster (for server 
installation only).

◆ A device with local affinity for the local bootstrap backup (server installation 
only). 
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System information requirements

Figure 4 on page 67 and Table 17 on page 67 display the system information needed 
to install the NetWorker cluster server. 

Figure 4 Sample cluster configuration

Note: In order to run HP-UX MC/LockManager within a cluster, the 
/etc/cmcluster/.nsr_cluster map file must be installed. “Task 3: Configure the .nsr_cluster 
file” on page 69 provides more information.

Different operating systems use different terms for the same cluster concepts. 
HP-UX MC/ServiceGuard and HP-UX MC/LockManager refer to:

◆ Physical hosts as nodes

◆ Virtual server as a package

Local
Disk 1

Shared Disks

Node B
clus_phys2

Node A
clus_phys1

Local
Disk 2

NetWorker
Virtual Server

(If Node 1 fails, 
clus_vir1 fails 

over to Node 2)

Private Network

Table 17 Required Information

Required information Example

NetWorker virtual name with one or more IP addresses clus_vir1,192.168.109.41

NetWorker package mount point for logical volume /vg011

Shared storage disk logical volume /dev/vg01/lvol1

NetWorker control script (provided by EMC) /etc/cmcluster/networker/legato.control

File containing the host IDs of all the cluster members /nsr/res/hostids

NetWorker monitor script (provided by EMC) /opt/networker/bin/legato.monitor

EMC nsr cluster file /etc/cmcluster/.nsr_cluster
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Installing a highly available NetWorker cluster-aware server
Use the following roadmap to install and configure NetWorker as a highly available 
application in a cluster:

◆ “Task 1: Install the NetWorker software within a cluster” on page 68

◆ “Task 2: Create the NetWorker.clucheck file” on page 69

◆ “Task 3: Configure the .nsr_cluster file” on page 69

◆ “Task 4: Define NetWorker software as highly available” on page 70

◆ “Task 5: Define the list of trusted NetWorker servers” on page 71

◆ “Task 6: Configure the cluster server” on page 71

◆ “Task 7: Make a cluster node a client of the NetWorker cluster server” on page 72

◆ “Task 8: Register NetWorker licenses for cluster server failover” on page 73

Task 1: Install the NetWorker software within a cluster
The NetWorker server software must be installed on all nodes in the cluster to 
provide failover support. Use the swinstall utility to install the NetWorker software 
within a cluster environment. 

To install the NetWorker server software:

1. Log in as root.

2. Ensure that the latest HP-UX file descriptor patches are installed.

3. To ensure that the NetWorker software is operating with consistent and proper 
settings:

a. Set the nfile value according to the following formula:

The nfile setting + (number of expected concurrent save times). The Number is a 
minimum of 50.

For example:
nfile = 1 X 50 

where 1 is the number of expected concurrent save sets.

b. Increase the maxfiles and maxfile_lim values to the following:

– maxfiles should be set at least 200.
– maxfile_lim should be set at least 2,048.
If the current values for these parameters are higher than the numbers stated, 
there is no need to adjust these parameters.

4. Change directories to the location of the NetWorker software distribution files:

• If installing from a local or remote CD-ROM, mount the NetWorker CD-ROM, 
and then change directories to where it is mounted.

• If installing from a downloaded web file, change to the directory from where 
the installation files from the download package are extracted.

The NetWorker Installation Guide provides installation instructions.
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5. Select the following packages from the NetWorker distribution CD-ROM:

• NWr-Client

• NWr-Node

• NWr-Server

Note: To install the NetWorker server within a cluster, install the NWR-Node software. 
Installing the NetWorker software storage node does not, however, provide support for 
shared devices other than file devices on shared disks.

6. Select Install from the Actions menu to run an install analysis. 

To verify the status of the install analysis:

a. Click Logfile to check the log file to verify that swinstall did not find errors. 

b. Correct any errors or problems before proceeding with the installation.

7. To proceed with the installation, click OK in the Install Analysis window, and 
then click Yes in the confirmation dialog box. 

The Install window displays the status of the installation when completed.

8. In the Install window, click Logfile to check the log file for error or warning 
messages generated during installation.

9. Type this command to start the NetWorker services:

/opt/networker/bin/nsrexecd

10. Type this command to verify that the NetWorker services are running:

ps -ef | grep nsr

The nsrexecd daemon should be running.

Task 2: Create the NetWorker.clucheck file
In the /etc/cmcluster directory, create the following file:

NetWorker.clucheck

Task 3: Configure the .nsr_cluster file
The NetWorker client software must determine an owning host for any paths that it 
saves. The NetWorker software determines which mount points an 
MC/ServiceGuard or MC/LockManager package owns by the entries in the 
.nsr_cluster file, located in the /etc/cmcluster/ directory. The .nsr_cluster file should 
have an entry for the NetWorker shared mount point, which is owned by the 
NetWorker package.

To configure the .nsr_cluster file: 

1. Add the name and path of each mount point to the file in the following format:

pkgname:published_ip_address:owned_path [:...]

where published_ip_address is the address assigned to the package owning a 
shared disk. 

2. Ensure that the ownership and access permissions for the .nsr_cluster file are 
"read" for World.
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3. Additional paths, preceded by colons, can be added as required. The following is 
an example of a typical .nsr_cluster file:

/etc/cmcluster/.nsr_cluster file. networker:192.168.109.41:/vg011

oracle:192.168.109.10:/vg021:/ora_data1:/ora_data2

Note: If an HP-UX MC/ServiceGuard package does not contain a disk resource, it does not 
require an entry in the .nsr_cluster file. However, if this diskless package is online and the 
only package on that cluster node, there might be cmgetconf messages generated in the 
var/admin message file during the backup.

To avoid these messages, allocate a file system that is mounted to a mount point and add 
this mount point along with the package name and IP address into the .nsr_cluster file in 
the format shown above. This file system is not backed up, but should be mountable on 
each cluster node that the diskless package might fail over to.

Task 4: Define NetWorker software as highly available

Note: Use the LVM to define the logical volumes or volume groups the NetWorker software 
will use. The HP-UX documentation provides more information regarding this procedure.

To define and configure the NetWorker software as highly available:

1. Run the networker.cluster script (located in the /opt/networker/bin directory) 
on one of the nodes where the NetWorker software is installed.

2. Follow the prompts to configure the NetWorker package.

The networker.cluster script creates a pkg.conf file and a legato.control file on 
the physical host on which it is running. 

3. Copy the legato.control file to all the nodes in the cluster and ensure that you set 
execute permissions.

4. After the legato.control file is copied to all the nodes in the cluster, run the 
networker.cluster script on the remaining nodes in the cluster. When the script 
prompts you to generate a legato.control file, type n.

5. Check each node to determine if the nsrexecd daemon is running:

ps -ef | grep nsrexecd

6. Check each node to determine if the legato.control file was successfully installed 
on each node: 

cd /etc/cmcluster/networker
more legato.control

7. On the node on which the networker.cluster script was initially run:

a. Determine if the pkg.conf file was installed correctly:

cd /etc/cmcluster/networker
cmcheckconf -P pkg.conf
cmapplyconf -P pkg.conf

b. Run the package:

cmrunpkg networker
cmmodpkg -e networker
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Task 5: Define the list of trusted NetWorker servers

To define the list of trusted NetWorker servers:

1. On one node in the cluster, shut down the NetWorker service by using the cluster 
management software.

2. On each node in the cluster:

a. Edit or create the /nsr/res/servers file and add the set of NetWorker servers, 
one per line, that requires access to this client.

b. Ensure that the first entry in this file is the virtual hostname for the NetWorker 
service. This entry becomes the default NetWorker server.

Note: If the /nsr/res/servers file is empty or does not exist, any NetWorker server is 
authorized to:
- Access and backup the client.
- Perform a directed recovery to the client.

c. Check the NetWorker boot-time startup file for nsrexecd -s arguments and 
delete any that exist. The nsrexecd -s argument supersedes the 
/nsr/res/servers file.

For example, delete the arguments for nsrexecd -s in the following file:

vi /sbin/init.d/networker
nsrexecd -s venus -s mars

The nsrexecd daemon named in the file should appear only as:

nsrexecd

d. Use the NetWorker boot-time startup file to stop and restart the NetWorker 
software, as follows:

/sbin/init.d/networker stop
/sbin/init.d/networker start

3. On one node in the cluster, start the NetWorker service by using the cluster 
management software.

4. On the node that is running the NetWorker server:

a. Edit or create the /nsr/res/servers file and add the set of NetWorker servers, 
one per line, that requires access to this client.

b. Ensure that the first entry in this file is the virtual hostname for the NetWorker 
service. This entry becomes the default NetWorker server.

c. Shut down and restart the NetWorker service by using the cluster 
management software.

Task 6: Configure the cluster server
To configure the NetWorker cluster server:

1. Log in to the cluster node that is running the NetWorker package.

2. Modify the /etc/hosts file to add the following name as an alias to the virtual 
hostname of the NetWorker server:

nsr host

Repeat this step on all relevant nodes. 
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3. Publish this name in the DNS or NIS. 

This ensures that the NetWorker software attempts to connect to the designated 
NetWorker server. 

4. Modify the Server resource:

a. From the Administration window, select File>Properties.

b. For the Administrator attribute, add entries for any cluster nodes that are not 
already listed. For example:

root@hostname

c. Click OK.

Task 7: Make a cluster node a client of the NetWorker cluster server

When the NetWorker client software is installed on a node, the installation creates a 
symbolic link, /nsr.NetWorker.local, that points to the directory containing the 
NetWorker configuration files. It also creates a link, /nsr, pointing to the 
/nsr.NetWorker.local. For example, if the local NetWorker directory was created in 
/var/nsr, each client member has the following links after the installation:

◆ /nsr->/nsr.NetWorker.local

◆ /nsr.NetWorker.local->/var/nsr

To make the cluster node a client of the NetWorker cluster server:

1. (Optional) Define save groups.

Note: In order for their save sets to restart after a virtual client or NetWorker server 
failover, save groups must have the Autorestart attribute enabled and the Manual Restart 
option disabled.

2. Make each physical node within the cluster a client of the NetWorker virtual 
server:

For each physical client in the cluster:

a. Create a new NetWorker client.

b. For the Name attribute, type the name of the physical client.

3. Make each virtual host within the cluster a client of the NetWorker virtual server.

For each virtual client in the cluster:

a. Create a new client.

b. For the Name attribute, type the name of the virtual client.

c. In the Remote Access attribute, type the user@hostname of each physical node 
within the cluster. For example:

root@clus_phys1

d. For the Group attribute, select a group.

The first time the NetWorker application runs, it creates the Client resource for 
the NetWorker virtual server. 
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4. Run a test probe to verify that the Client and Group resources have been properly 
configured.

On the node on which the NetWorker server resides, run this command:

savegrp -pv -c client_name group_name

If the test probe does not display the scheduled backups and index, see “Tracking 
scheduled saves” on page 77 for more information.

Task 8: Register NetWorker licenses for cluster server failover

To register a NetWorker server in a cluster environment:

1. Ensure that the NetWorker virtual server is defined as a part of the cluster.

2. Ensure that the NetWorker service is running.

3. For each physical node in the cluster:

a. Relocate, sequentially, the NetWorker server to this node.

b. From the NetWorker Administration window, note the host ID number for 
the appropriate cluster license.

4. Log in to the system that is running the NetWorker virtual server and create a file 
named /nsr/res/hostids that contains the host IDs of all the cluster nodes. 

Use the following syntax:
hostid1:hostid2:hostid3:... 

For example:
12345678:87654321

5. Restart the server by taking the NetWorker virtual server offline and then putting 
it back online.

6. From the NetWorker Administration window, note the host ID number for the 
appropriate cluster license.

7. Register the NetWorker software. 

Installing only the NetWorker client software in a cluster
Use the following roadmap to install the NetWorker cluster client:

◆ “Task 1: Install the NetWorker cluster client software” on page 74

◆ “Task 2: Create the NetWorker.clucheck file” on page 74

◆ “Task 3: Configure the .nsr_cluster file” on page 75

◆ “Task 4: Define the list of trusted NetWorker servers” on page 75

◆ “Task 5: Make a cluster node a client of the NetWorker server” on page 76

Note: Install the NetWorker client software on every node in the cluster that needs to be 
backed up.
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Task 1: Install the NetWorker cluster client software

To install the NetWorker software on each node in the cluster:

1. Log in as root.

2. Ensure that the latest HP-UX file descriptor patches are installed.

Note: To ensure that the NetWorker software is operating with consistent and proper 
settings:

a. Set the nfile value according to the following formula:

The nfile setting + (number of expected concurrent save times). The Number is a 
minimum of 50

For example:
nfile = 1 X 50 

where 1 is the number of expected concurrent save sets.

b. Increase the maxfiles and maxfile_lim values to the following:

– maxfiles should be set at least 200.
– maxfile_lim should be set at least 2,048.
If the current values for these parameters are higher than the numbers stated, 
there is no need to adjust these parameters.

3. Select only the NW-Client package.

4. Select Install (analysis) from the Actions menu to run an install analysis. 

To verify the status of the install analysis:

a. Click Logfile to check the log file to verify that swinstall did not find errors. 

b. Correct any errors or problems before proceeding with the installation.

5. To proceed with the installation, click OK in the Install Analysis window, and 
then click Yes in the confirmation dialog box.

The Install window displays the status of the installation. When the installation is 
finished, the Status field displays Completed.

6. Click Logfile to check the log file in the Install window, for error or warning 
messages generated during installation.

7. Type this command to start the NetWorker services:

/sbin/init.d/networker start

8. Type the following command to verify that the NetWorker services are running:

ps -ef | grep nsr

The nsrexecd daemon should be running.

Task 2: Create the NetWorker.clucheck file
In the /etc/cmcluster directory, create the following file:

NetWorker.clucheck
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Task 3: Configure the .nsr_cluster file

The NetWorker client software must determine an owning host for any paths that it 
saves. The NetWorker software determines which mount points an 
MC/ServiceGuard or MC/LockManager package owns by the entries in the 
.nsr_cluster file, located in the /etc/cmcluster/ directory. 

Note: If an HP-UX MC/ServiceGuard package does not contain a disk resource, it does not 
require an entry in the .nsr_cluster file. However, if this diskless package is online and the only 
package on that cluster node, there might be cmgetconf messages generated in the var/admin 
message file during the backup.

To avoid these messages, allocate a file system that is mounted to a mount point and 
add this mount point along with the package name and IP address into the 
.nsr_cluster file in the format shown above. This file system is not backed up, but 
should be mountable on each cluster node that the diskless package might failover to.

To configure the .nsr_cluster file: 

1. Add the name and path of each mount point to the file in the following format:

pkgname:published_ip_address:owned_path [:...]

where published_ip_address is the address assigned to the package owning a 
shared disk. 

2. Ensure that the ownership and access permissions for the .nsr_cluster file are 
"read" for World.

3. Additional paths, preceded by colons, can be added as required. The following is 
an example of a typical .nsr_cluster file:

/etc/cmcluster/.nsr_cluster file. networker:192.168.109.41:/vg011

oracle:192.168.109.10:/vg021:/ora_data1:/ora_data2

Task 4: Define the list of trusted NetWorker servers
To define the list of trusted NetWorker servers, one each node in the cluster:

1. Edit or create the /nsr/res/servers file and add the set of NetWorker servers, one 
per line, that requires access to this client.

Note: If the /nsr/res/servers file is empty or does not exist, any NetWorker server is 
authorized to: 
- Access and backup the client.
- Perform a directed recovery to the client.

2. Check the NetWorker boot-time startup file for nsrexecd -s arguments and delete 
any that exist. The nsrexecd -s argument supersedes the /nsr/res/servers file. 

For example, delete the arguments for nsrexecd -s in the following file:

vi /sbin/init.d/networker

nsrexecd -s venus -s mars

The nsrexecd daemon named in the file should appear only as:

nsrexecd
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3. Use the NetWorker boot-time startup file to stop and restart the NetWorker 
software, as follows:

/sbin/init.d/networker stop

/sbin/init.d/networker start

Task 5: Make a cluster node a client of the NetWorker server

When the NetWorker client software is installed on a node, the installation creates a 
symbolic link, /nsr.NetWorker.local, that points to the directory containing the 
NetWorker configuration files. It also creates a link, /nsr, pointing to the 
/nsr.NetWorker.local. For example, if the local NetWorker directory was created in 
/var/nsr, each client member has the following links after the installation:

◆ /nsr->/nsr.NetWorker.local

◆ /nsr.NetWorker.local->/var/nsr

To make the cluster node a client of the NetWorker server:

1. (Optional) Define save groups as required.

Note: In order for their save sets to restart after a virtual client or NetWorker server 
failover, save groups must have the Autorestart attribute enabled and the Manual Restart 
option disabled.

2. Make each physical client within the cluster a client of the NetWorker server. For 
each physical client in the cluster:

a. Create a new client.

b. For the Name attribute, type the name of the physical client.

Note: If a physical client is backed up to a NetWorker server outside the cluster, the name 
of any virtual service that can run on the physical node must be added to the Remote 
Access list of the physical Client resource.

3. Make each virtual client within the cluster a client of the NetWorker server. For 
each virtual client in the cluster:

a. Create a new client.

b. For the Name attribute, type the name of the NetWorker server.

c. In the Remote Access attribute, type the user@hostname of each physical node 
within the cluster. For example:

root@clus_phys1

d. For the Group attribute, select a group.

e. Define the remaining attributes in the Client window, and then click Apply.

4. Schedule backups by using the NetWorker application. 

5. Run a test probe to verify that the Client and Group resources have been properly 
configured.

On the node on which the NetWorker server resides, type:

savegrp -pv -c client_name group_name

If the test probe does not display the scheduled backups and index, see “Tracking 
scheduled saves” on page 77 for more information.
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Uninstalling the NetWorker software
To remove the NetWorker software from a cluster environment: 

1. Halt the NetWorker package:

cmhaltpkg networker

2. Shut down the client services on each node from which the NetWorker software 
is being removed:

nsr_shutdown

3. To keep the NetWorker server software in the cluster, migrate it to another node 
in the cluster, type:

cmrunpkg -n clus_phys1 -v networker

To avoid running the NetWorker server software in the cluster, proceed to step 6.

4. Run this command:

/opt/networker/bin/networker.cluster -r

5. Remove the following file from the /etc/cmcluster directory:

NetWorker.clucheck

6. Remove the NetWorker package software. The EMC NetWorker Installation Guide 
provides information on how to uninstall the software.

Tracking scheduled saves
To verify that the Client and Group resources are properly configured, run a test 
probe for each client from the node where the NetWorker application is running:

savegrp -pv -c client_name group_name

If the test probe does not display all the scheduled save sets:

◆ Check the cluster configuration by using the cluster management software. If 
necessary, reconfigure the cluster.

◆ Ensure that the save sets defined for the client are owned by that client. If 
necessary, redistribute the client save sets to the appropriate Client resources. 

Note: Misconfiguration of the Cluster resources might cause scheduled save sets to be 
dropped from the backup. The EMC NetWorker Administration Guide provides more 
information.

◆ Type this command to override scheduled save rules (not path ownership rules):

touch networker_bin_dir/pathownerignore

◆ Run a second test probe to verify the configuration.

This command allows any path to be backed up for a client, whether it is owned 
by the virtual client or physical node. The EMC NetWorker Administration Guide 
provides more information.
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If the pathownerignore command was used, check that the NetWorker scheduled 
save uses the correct client index. If the wrong index is used, the save sets can be 
forced to go to the correct index:

1. From the NetWorker Administration window, select a client and edit its 
properties.

2. For the Backup Command attribute, type the name of a backup script that 
contains 
save -c client_name. 

The EMC NetWorker Administration Guide provides details about the Backup 
Command attribute.
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Cluster terminology
NetWorker documentation uses the following cluster terminology:

◆ Node — A physical computer that is a member of a cluster.

◆ Private disk — A local disk on a cluster node. A private disk is not available to 
other nodes within the cluster.

◆ Shared disk — A disk that is shared by the cluster nodes.

◆ Failover — A means of ensuring application availability by relocating resources 
in the event of a hardware or software failure. Two-node failover capability 
allows operations to switch from one cluster node to the other. Failover capability 
can also be used as a resource management tool.

◆ Highly available application — An application that is installed in a cluster 
environment and configured for failover capability.

◆ Cluster-aware NetWorker server — A NetWorker server that can recognize 
cluster clients.

◆ Cluster client — A NetWorker client within a cluster; this can be either a virtual 
client, or a NetWorker Client resource that backs up the private data that belongs 
to one of the physical nodes.

◆ Virtual client — A NetWorker Client resource that backs up data that belongs to a 
highly available service or application within a cluster. Virtual clients can fail 
over from one cluster node to another.

◆ Stand-alone server — A NetWorker server that is running within a cluster, but not 
configured as a highly available application. A stand-alone server does not have 
failover capability.

◆ Virtual server — A NetWorker server that is configured to run as a highly 
available application. A virtual server can fail over from one cluster node to 
another.

Installation requirements
This section specifies the software and hardware required to install and configure the 
NetWorker server and client software within a MSCS environment. The MSCS 
software must be installed in a Microsoft certified hardware configuration.

All nodes must have one of the following installed:

◆ Microsoft Windows Server 2003, Standard, Enterprise, and Datacenter Editions, 
32-bit version, two-node and four-node support, NetWorker server support

◆ Microsoft Windows Server 2003, Enterprise or Datacenter Edition, 32-bit version, 
two-node and four-node support, NetWorker client support

◆ Microsoft Windows 2000, Advanced Server or Datacenter with the latest service 
pack installed, two-node support, NetWorker server and client support

Note: If a Windows 2000 service pack earlier than SP3 is used, the Microsoft 
Gethostbyaddr( ) patch must be applied (available from Microsoft Product Support 
Services).

◆ Microsoft Windows NT 4.0 Server, Enterprise Edition, with MSCS and the latest 
service pack installed, NetWorker client support

◆ NetWorker software must always be installed on the private disk of a node.
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Updating NetWorker software

Note: For more information about MSCS, and detailed procedures for using the Microsoft 
Management Console (MMC) Cluster Administrator snap-in, refer to the Microsoft 
documentation.

To update the NetWorker server software in an MSCS environment, on one node in 
the cluster:

1. In the Cluster Administrator program, take the NetWorker server Cluster 
resource group offline.

2. Rename the NetWorker_install_path>\bin\NetWorker.clustersvr file to 
NetWorker_install_path>\bin\NetWorker.nocluster.

3. Update the NetWorker software. The NetWorker Installation Guide provides 
instructions.

4. Stop the NetWorker Backup and Recover Server service.

5. Open the NetWorker Backup and Recover Server Properties dialog box and 
change the startup type from Automatic to Manual.

6. Rename the NetWorker.nocluster file NetWorker.clustersvr.

7. On the second node of the cluster:

a. Rename the NetWorker_install_path>\bin\NetWorker.clustersvr file to 
NetWorker_install_path>\bin\NetWorker.nocluster.

b. Update the NetWorker software.

c. Stop the NetWorker Backup and Recover Server service.

d. Open the NetWorker Backup and Recover Server Properties dialog box and 
change the startup type from Automatic to Manual.

e. Rename the NetWorker.nocluster file back to NetWorker.clustersvr.

8. Bring the NetWorker server Cluster resource group back online.

NetWorker server installation
Microsoft documentation provides information about MSCS and detailed procedures 
for using the MMC Cluster Administrator snap-in.

Installing a NetWorker server for noncluster mode
To run the NetWorker server in noncluster mode within a cluster, the NetWorker 
server software must be installed as a stand-alone application. The NetWorker 
Installation Guide provides detailed installation instructions. 

Note: If you install NetWorker software without rebooting, running the cluster administrator 
for the first time can result in an error due to the cluster administrator extension DLL not being 
reloaded. If this error occurs, close the cluster administrator interface and run the following 
from the command line to reload the the following:
regsvr32 /u nsrdresex.dll
Updating NetWorker software 81



Microsoft Cluster Server (MSCS) Installation
In this configuration, the NetWorker server software is usually installed on only one 
of the nodes in the cluster, and the NetWorker client software is installed on each 
node in the cluster.

The following rules apply:

◆ No failover of the NetWorker server takes place.

◆ The NetWorker server does not have to be configured as a resource managed by 
the cluster.

◆ The cluster service might or might not be running.

Installing a NetWorker server for cluster mode

The following sections explain how to configure a NetWorker server as a highly 
available application in MSCS:

◆ “Task 1: Install the NetWorker software” on page 82

◆ “Task 2: Create and register the cluster resource type” on page 83

◆ “Task 3: Verify the NetWorker server resource type” on page 83

◆ “Task 4: Create an MSCS group resource and required components resource” on 
page 83

◆ “Task 5: Bring the NetWorker Server resource online” on page 85

◆ “Task 6: Configure the NetWorker virtual server” on page 86

◆ “Task 7: Configure clients on the NetWorker cluster server” on page 86

Task 1: Install the NetWorker software
On each node in the cluster, install NetWorker software in the same location on a 
private disk. 

To install the software:

1. Log in as administrator to the node where you will install NetWorker software

2. On one node in the cluster, complete the installation. From the NetWorker 
Administration window, note the host ID number for the appropriate cluster 
license. 

3. On the second node in the cluster:

a. Complete the installation. 

b. From the NetWorker Administration window, note the host ID number for 
the appropriate cluster license.

The NetWorker Installation Guide provides detailed installation instructions. 

Note: The host ID is needed for the procedure “Registering NetWorker licenses for cluster 
failover” on page 89. 
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Task 2: Create and register the cluster resource type
To create and register the cluster resource type:

1. Verify that NetWorker server software is installed in the same location on each 
node in the cluster.

2. On one of the cluster nodes, type:

regcnsrd -c 

This creates the NetWorker Server cluster resource type. It also registers the 
resource extension module so the NetWorker Server resource type can be 
managed from this node.

3. On the second cluster node, type:

regcnsrd -r 

If prompted with the following, type Y:

Is this machine a member of the cluster on which you want to 
register Resource Extension for NetWorker Server resource?

This registers the resource extension module so the NetWorker Server resource 
type can be managed from this node.

Task 3: Verify the NetWorker server resource type
To verify that a NetWorker Server resource type exists:

1. In the Cluster Administrator program, select Resource Type under the Cluster 
Configuration.

2. Verify that NetWorker Server is listed as a resource type.

The resource types: IP Address and Network Name define the NetWorker server’s 
virtual identity. The Physical Disk resource type is for the shared nsr directory.

Task 4: Create an MSCS group resource and required components resource
To create the NetWorker virtual server Group resource: 

1. In the Cluster Administrator program, select the Disk Group in the Groups 
folder that contains the shared disk to associate with the NetWorker server. You 
can rename this Disk Group. For this procedure, the Disk Group was renamed to 
NetWorker Group.

Note: The NetWorker server must have its own dedicated Shared Disk resource. The 
cluster service quorum disk cannot be used for this.

2. Select the NetWorker Group (Disk Group) that was identified in the previous 
step and create the following resources for the NetWorker Group:

• “NetWorker IP Address resource” on page 84

• “NetWorker Network Name resource” on page 84

• “NetWorker Server resource” on page 85

Note: Do not create multiple instances of the NetWorker Server resources. Creating more 
than one instance of a NetWorker Server resource interferes with how the existing 
NetWorker Server resources function.
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NetWorker IP Address resource
To create a NetWorker IP Address resource:

1. In the Cluster Administrator program, select File>New>Resource.

2. Complete the following attributes:

Name: NSR_IP

Description: NetWorker IP Address

Resource Type: IP Address

Group: NetWorker Group

Note: For the Name attribute, type any descriptive name (without spaces). For the 
Description attribute, type any descriptive text.

3. Click Next. In the Possible Owners dialog box, type the hostname of each 
required node in the cluster. For example:

Possible Owners: uranus, pluto 

4. Click Next. In the Dependencies dialog box, specify the shared disk you 
associated with the NetWorker virtual server. For example:

Dependencies: Disk P:

5. Click Next. In the TCP/IP Address Parameters dialog box, type the IP address of 
the NetWorker virtual server. For example:

10.0.0.4

NetWorker Network Name resource
To create a NetWorker Network Name resource:

1. In the Cluster Administrator program, select File>New>Resource.

2. Complete the following attributes:

Name: NSR_NetworkName

Description: NetWorker Network Name

Resource Type: Network Name

Group: NetWorker Group

Note: For the Name attribute, type any descriptive name (without spaces). For the 
Description attribute, type any descriptive text.

3. Click Next. In the Possible Owners dialog box, type the hostname of each 
required node in the cluster. For example:

Possible Owners: pluto, uranus

4. Click Next. In the Dependencies dialog box, type the name of the NetWorker IP 
Address resource. For example:

Dependencies: NSR_IP

5. Click Next. In the Network Name Parameters dialog box, type the name of the 
NetWorker virtual server. For example:

Name: neptune
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NetWorker Server resource
To create a NetWorker Server resource:

1. In the Cluster Administrator program, select File>New>Resource.

2. Complete the following attributes:

Name: NSR_Server

Description: NetWorker Server Resource 

Resource Type: NetWorker Server

Group: NetWorker Group

Note: For the Name attribute, type any descriptive name (without spaces). For the 
Description attribute, type any descriptive text. For the Resource Type attribute, type the 
name of the resource type created in “Task 2: Create and register the cluster resource type” 
on page 83.

3. Click Next. In the Possible Owners dialog box, type the hostname of each 
required node in the cluster. For example:

Possible Owners: pluto, uranus

4. Click Next. In the Dependencies dialog box, type the name of the NetWorker 
Network Name resource. For example:

Dependencies: NSR_NetworkName

5. Click Next. In the NetWorker Server Parameters dialog box, complete the 
following attributes:

Server Name: (leave blank)

NsrDir: P:\nsr

Additional Arguments: (leave blank)

Note: The directory path entered for the NsrDir attribute must reside on the NetWorker 
server shared disk.

6. After completing these steps, a message appears indicating that the resource was 
successfully created. Verify that a new NetWorker Server type resource was 
created in the selected resource group.

Note: The MSCS software provides an option to set up an application of the Generic 
Application type within a Group resource. Do not create a Generic Application resource 
for the NetWorker virtual server.

Task 5: Bring the NetWorker Server resource online
To bring the NetWorker Server resource online:

1. In the Cluster Administrator program, select the resource group where the 
NetWorker Server resource exists.

2. Select the NetWorker Server resource.

3. Select Bring Online from the File menu to bring the NetWorker server online. 
The state of the NetWorker Server resource changes to Online Pending.

4. Wait until the state of the NetWorker Server resource changes to Online.

These steps stop the NetWorker Remote Exec service and restart all of the 
NetWorker services.
NetWorker server installation 85



Microsoft Cluster Server (MSCS) Installation
Task 6: Configure the NetWorker virtual server
To configure the NetWorker virtual server:

1. Log in to the cluster node that is running the NetWorker virtual server.

2. From the Administration window, select File>Properties.

a. For the Administrator attribute, add entries for any cluster nodes that are not 
already listed. For example:

administrator@cluster_phy1

b. Click OK.

Note: To specify which NetWorker servers can back up a particular client, edit the 
NetWorker_install_path\res\servers file and add the NetWorker virtual host and each cluster 
node.

Task 7: Configure clients on the NetWorker cluster server
To configure a NetWorker client to back up the quorum data:

1. In the Cluster Administrator program, verify that the same physical node owns 
the cluster group and quorum disk.

2. Select the disk group that contains the quorum disk.

3. Drag the quorum disk to the cluster group.

To configure the NetWorker Client resource:

1. Log in to the cluster node that is running the NetWorker virtual server.

2. Add the NetWorker virtual server to the hosts file on each node (located in 
%SystemRoot%\system32\drivers\etc).

3. Start the NetWorker Management Console software.

Make each physical node within the cluster a client of the NetWorker virtual 
server. For each physical node in the cluster:

a. Create a new Client resource.

b. For the Name attribute, type the name of the physical host.

The NetWorker Administration Guide details how to create a Client resource.

4. Make each virtual server within the cluster a client of the NetWorker virtual 
server. For each virtual node in the cluster:

a. Create a new Client resource.

b. For the Remote Access attribute, type the user@hostname of each physical 
node within the cluster.

5. Define one or more NetWorker Group resources to include the NetWorker 
virtual server and each of the physical nodes in the cluster:

a. Create the necessary groups and define their attributes as appropriate.

b. For each group, select Enabled for the Autorestart attribute.

c. For each group, ensure that Manual Restart is not selected in the Options 
attribute (under the Preferences tab). 
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Note: The only save sets that restart after a virtual client failover are those that belong to a 
group in which Autorestart is enabled and Manual Restart is disabled.

6. Run a test probe to verify that the Client and Group resources are properly 
configured. On the node on which the NetWorker server resides, run this 
command: 

savegrp -pv -c client_name group_name

If the expected scheduled backups and index do not appear, perform the 
following workaround:

a. Create an empty file named pathownerignore in the directory where the 
NetWorker savefs command is installed (the default location is 
NetWorker_install_path\bin). This allows a valid save set to be scheduled for 
backup for a NetWorker client. 

This file must be created on each NetWorker server and NetWorker client host 
in the cluster. 

b. To bypass the default ownership scheduling rules, run this command:

echo NUL: > NetWorker_install_path\bin\pathownerignore

This command allows any path to be scheduled for backup for a NetWorker 
client.

Note: A NetWorker scheduled save might use a client index name other than the one 
you want it to. To override this default, run a manual save with the -c option:
save -c client_name 
To restrict the set of NetWorker servers that can back up a particular client, edit the 
NetWorker_install_path\res\servers file to add the NetWorker virtual host as well as 
each cluster node to the list of servers.

After the client configuration is complete:

◆ The NetWorker cluster server uses the IP address of the NetWorker virtual host, 
regardless of which cluster node currently masters the NetWorker virtual server.

◆ The NetWorker cluster server takes the identity of the NetWorker virtual server’s 
hostname, regardless of which cluster node is currently running the NetWorker 
service.

◆ The first time NetWorker software runs, it creates the Client resource for the 
NetWorker virtual host. Client resources must be created manually for any 
cluster node that is to be backed up by the NetWorker virtual host.

Configuring a backup device for the NetWorker virtual server
The NetWorker virtual server must be configured with storage node backup devices. 
The storage nodes the NetWorker virtual server uses can be devices attached to a 
remote system (external to the cluster). They can also be devices connected locally to 
any of the physical nodes in the cluster. A storage node device can be a stand-alone 
tape drive or an autochanger. 

The NetWorker Administration Guide details how to configure storage nodes.

Note: MSCS does not support shared tapes. You cannot configure the NetWorker virtual server 
with tape devices connected to a shared bus. 
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MSCS does support disk devices connected to a shared bus. However, it is strongly 
recommended that you not use file type devices connected to a shared bus.

The NetWorker virtual server requires a local backup device to save the bootstrap 
and the server indexes. With releases 6.0 and later, the NetWorker virtual server 
bootstrap and indexes can be also saved to a storage node. The storage node device, 
in such a case, must be attached to the cluster node on which the NetWorker virtual 
server is currently running.

A NetWorker virtual server running on a two-node cluster requires the following 
minimum device configuration:

◆ Each cluster node must be configured as a storage node for the NetWorker virtual 
server. For instructions, see “Defining a cluster node as a storage node” on 
page 88.

◆ The Storage Nodes attribute for the NetWorker virtual server (under the 
Preferences tab in the Client resource) must list the storage nodes enabled to store 
data for the client.

Each of the storage nodes must be listed before you can list the nsrserverhost:

a. One cluster node

b. The other cluster node

c. The nsrserverhos

Note: The nsrserverhost must be listed last in each client's storage node list.

You cannot configure a storage node on a cluster node that is running the NetWorker 
server software. Consequently, before you configure a storage node, you must move 
the NetWorker virtual server to another node in the cluster.

Defining a cluster node as a storage node

To define each cluster node as a storage node for the NetWorker virtual server:

1. Log in to a cluster node that does not currently own the NetWorker virtual server.

2. Configure the cluster node as a NetWorker storage node. The NetWorker 
Administration Guide provides detailed instructions.

3. In the Cluster Administrator program, move the NetWorker virtual server to 
another node in the cluster.

4. Once you have moved the NetWorker virtual server to the other node:

a. Log in to a cluster node that does not currently own the NetWorker virtual 
server.

b. Configure the cluster node as a NetWorker storage node.

Note: The NetWorker Remote Exec service must be running on each storage node within the 
cluster.
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Moving the NetWorker server to another node
To move the NetWorker server from one node to another within the cluster, use the Cluster 
Administrator program to move the resource group that contains the NetWorker Server 
resource from one node to another:

1. Select the resource group where the NetWorker Server resource exists.

2. Select Move Group from the File menu to change the state of the resources in this group 
to Offline Pending. 

This brings all the resources in the current node offline. It also brings all the resources in 
the other node in the cluster online.

3. Wait until the state of all the resources in the group becomes Online again.

Registering NetWorker licenses for cluster failover

Note: To register NetWorker licenses for cluster failover, first complete all tasks under “Installing a 
NetWorker server for cluster mode” on page 82.

1. Ensure the NetWorker virtual server is online.

2. Log on to the cluster node on which the NetWorker virtual server is running.

3. Create a file named hostids in the NetWorker_install_path\res directory. The file name 
must not have a file extension.

4. Add one line to the hostids file, in the following format:

hostid1:hostid2

where the host ID are the NetWorker server host ID values obtained in: “Task 1: Install 
the NetWorker software” on page 82.

5. Restart the NetWorker virtual server by taking it offline and then bringing it back online.

Note: The host ID now displayed in the NetWorker Administrator program (or by running the 
lgtolic -i command) is the composite hostid. This composite host ID is required for permanent 
registration in a clustered environment.

6. Register the NetWorker software for permanent use. Chapter 10, ”Licensing and Enabling 
the Software” provides information on registering NetWorker software.

Restarting the NetWorker server services

Note: Start the NetWorker server manually in a cluster environment only if it is running as a 
stand-alone server.

If the NetWorker server is configured as a cluster group resource, then you must start or 
restart the NetWorker services through the cluster software. 

“Task 5: Bring the NetWorker Server resource online” on page 85 describes how to start the 
NetWorker server within cluster mode. Use the Cluster Administrator program to restart the 
NetWorker server services in the current node by taking the server offline and bringing it 
back online.
Moving the NetWorker server to another node 89



Microsoft Cluster Server (MSCS) Installation
Installing only the NetWorker client software in a cluster
To install the NetWorker client software as a highly available application:

1. Install the NetWorker client software on the private disk of each node in the 
cluster. 

2. Configure each node in the cluster as a client of the NetWorker server. These are 
physical cluster clients.

If the NetWorker server is configured as a Cluster resource, add the hostname 
and user of this NetWorker virtual server to the following Client resource 
attributes of the physical cluster clients:

• Remote Access

• Administrator

3. Configure each of the virtual servers in a cluster as a client of the NetWorker 
virtual server. These are virtual cluster clients.

4. Add the hostname and user of each node to the following Client resource 
attributes of the virtual clients:

• Remote Access

• Administrator

Uninstalling the NetWorker software from MSCS
If the NetWorker server is configured as a cluster resource, perform the following 
steps before removing the NetWorker software.

If the NetWorker server is installed as a stand-alone application (not cluster 
managed) or only the client software is installed, follow the standard uninstall 
procedure for NetWorker software. The NetWorker Installation Guide provides 
instructions on how to uninstall the software.

Note: Before uninstalling NetWorker software from a cluster node, close the Cluster 
Administrator program on the NetWorker server.

From all the nodes in the cluster
To uninstall NetWorker software from all the nodes in the cluster:

1. Unregister and remove the NetWorker Server resource:

a. In the Cluster Administrator program, select File>Take Offline to bring the 
NetWorker Server resource Offline.

b. Select File>Delete to delete the NetWorker Server resource from MSCS.

c. Run the regcnsrd -u command on all but the last member of the cluster. 

If you are prompted with the following question, type y:

Is this machine a member of the cluster on which you want to 
un-register Resource Extension for NetWorker Server resource?

d. Run the regcnsrd -d command on the last member of the cluster.
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2. Close the Cluster Administrator program on all the nodes where you plan to 
uninstall NetWorker software.

3. Uninstall the NetWorker software from all nodes. 

From only one node in the cluster

Use the following procedure if the NetWorker server software is installed on more 
than one node and all these nodes are possible owners that can host the NetWorker 
Server resource.

To uninstall NetWorker software from only one node in the cluster:

1. From one node in the cluster, run the regcnsrd -u command. 

If you are prompted with the following message, type y:

Is this machine a member of the cluster on which you want to 
un-register Resource Extension for NetWorker Server resource?

2. Log in to another node in the cluster that can host the NetWorker server.

3. Remove the node that you are uninstalling from the Possible Owners attribute in 
the NetWorker Server resource.

Note: To determine the possible owners of the NetWorker Server cluster resource, review 
the properties of the NetWorker Server resource.

4. Close the Cluster Administrator program on the node where you plan to 
uninstall the NetWorker software.

5. Uninstall the NetWorker software from the node. 

The NetWorker Installation Guide provides detailed instructions.

Troubleshooting NetWorker software in the MSCS environment
The following sections provide tips for troubleshooting problems with the 
NetWorker software in an MSCS environment.

NetWorker virtual server fails to start nsrmmd

If the NetWorker virtual server fails to start nsrmmd on a NetWorker storage node, 
the following error messages are written into the NetWorker server daemon.log file:

06/08/00 10:00:11 nsrmon #217: connect to nsrexec prog 390113 vers 1 
on `uranus' failed: RPC error: Remote system error
06/08/00 10:00:11 nsrd: media notice: check storage node: uranus (RPC 
error: Remote system error)
06/08/00 10:00:11 nsrd: media info: restarting nsrmmd #1 on uranus in 
2 minute(s)
06/08/00 10:02:12 nsrd: media info: restarting nsrmmd #1 on uranus now
06/08/00 10:02:42 nsrmon #183: connect to nsrexec prog 390113 vers 1 
on `

The error might be caused by the NetWorker Remote Exec service not running on the 
storage node. 
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If the NetWorker Remote Exec service is not running:

1. On the Storage Node, select Services from the Control Panel.

2. Right-click the NetWorker Remote Exec service name and select Start.

NetWorker server fails to back up a virtual cluster client

If a NetWorker server fails to backup a virtual cluster client, an error message could 
appear.

In this example, the following names appear:

◆ charon — Virtual cluster client running on pluto

◆ pluto — Physical cluster node

◆ neptune — NetWorker server

06/19/03 12:56:57 nsrd: savegroup alert: test completed, 1 client(s) 
(charon Failed) charon:Q:\: No save sets with this name were found in 
the media database; performing a full backup

charon:Q:\ save: RAP error: Unable to extract resource info for client 
pluto.emc.com.
charon:Q:\ save: Cannot open save session with neptune.emc.com
charon:Q:\ 1 retry attempted
charon:Q:\: No save sets with this name were found in the media 
database; performing a full backup
charon:Q:\ save: RAP error: Unable to extract resource info for client 
pluto.emc.com.
charon:Q:\ save: Cannot open save session with neptune.EMC.com

06/19/03 12:56:57 nsrd: runq: NSR group test exited with return code 1

This error might occur because the NetWorker Client resources for each of the 
physical nodes in the cluster are missing.

To correct the error:

1. Create a NetWorker Client resource for each physical node that is allowed to 
own the virtual cluster client.

2. Rerun the backup.

NetWorker services fail to start in an MSCS environment
If the NetWorker services fail to start in an MSCS environment:

1. Check for a file named NetWorker_install_path\bin\NetWorker.clustersvr.

2. If the NetWorker.clustersvr file does not exist, create an empty file with that 
name.

3. Select Services from the Control Panel.

4. Right-click the NetWorker Remote Exec service name and select Start.
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Software installation roadmap
These tasks are a roadmap to follow when installing the NetWorker software:

1. Review “Installation requirements” on page 94 and note the default directory 
location.

2. Install the required NetWorker software by following one of these procedures:

• “Installing a NetWorker virtual server” on page 97

• “Installing a virtual NetWorker Console server” on page 106

• “Installing only the NetWorker client software in a cluster” on page 108

3. Enable and register all of the NetWorker products. Chapter 10, ”Licensing and 
Enabling the Software,” provides detailed information.

Installation requirements
This section specifies the software and hardware required for installing and setting 
up the NetWorker server or client software within a Sun Cluster environment:

The EMC Information Protection Software Compatibility Guide provides the most 
up-to-date information about software and hardware requirements.

Software requirements

The following software must be installed on each node in the cluster:

◆ Solaris 8 or Solaris 9 operating environment is installed

◆ Sun Cluster version 3.0 or 3.1 is installed

◆ Volume Manager software (Solstice DiskSuite/Solaris Volume Manager)

Note: Highly available storage nodes are not supported.

Hardware requirements 

The following hardware requirements must be met:

◆ A multihosted disk is used as a mount point for the global file systems. These 
contain the shared /nsr area.

◆ A device with local affinity for the local bootstrap backup that is connected to all 
the nodes within the cluster.
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Configuration options

Refer to the NetWorker Administration Guide for information about:

◆ Tape libraries with a NetWorker virtual server

◆ Remote physical storage node with a NetWorker virtual server

System information requirements

Table 18 on page 95 and Figure 5 on page 95 display the system information needed 
to install highly available NetWorker software within a Sun Cluster environment.

Figure 5 Sample cluster configuration

Table 18 System information

Information Required Example

NetWorker virtual hostname with an IP address in the same subnet as 
the cluster nodes

clus_vir1
192.168.1.10

NetWorker globally mounted configuration area /global/nw

NetWorker cluster configuration script /usr/sbin/networker.cluster

File containing the host ID of all the cluster members /nsr/res/hostids

Node 1 
clus_phys1

Node 2 
clus_phys2

Private Network

Local Disk Local Disk
clus_log1

If Node1fails,
clus_log1 fails
over to Node2

Public NetWork

Volume-managed Shared Disks

Terminal Concentrator

Administrative 
Workstation

NetWorker Logical Host 
(Virtual Server)
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Updating from a previous release of NetWorker software
To update from NetWorker releases 6.1.x and 7.x to NetWorker release 7.3 in a Sun 
Cluster 3.0 or 3.1 environment:

1. Collect this NetWorker software system information:

• The location of the NetWorker server global /nsr directory on the shared 
storage.

• The location of the NetWorker client local /nsr directories.

2. List and save the cluster resource group configuration:

scrgadm -pvv > scrgadm_pvv.out

scconf -pvv > scconf_pvv.out

3. Use NetWorker software to back up the cluster. Ensure that you have a recent 
backup of the indexes and bootstrap by using the savegrp -O command.

4. Remove the NetWorker software cluster configuration files and uninstall the 
NetWorker software. Do not remove the global and local /nsr directories.

For instructions on uninstalling the NetWorker software, see “Uninstalling the 
NetWorker software” on page 112.

5. If required, upgrade the Sun Cluster software. For instructions, refer to the Sun 
Cluster documentation.

6. Install and configure the NetWorker 7.4 Service Pack 1 software.

Note: Do not relocate the NetWorker software. By default, the NetWorker is installed in 
the /usr directory.

7. Ensure that:

• You specify the same local /nsr and global /nsr directories.

• The NetWorker Client Type resource properties for Owned_paths and 
Clientname are the same as before the upgrade.

• The NetWorker Config_dir resource contains the same values as before the 
upgrade.

• The Network_resources_used property contains the same value that the 
Resource_dependencies property had before the upgrade.

Installing NetWorker software in a cluster
See these sections to install the NetWorker software in a Sun Cluster environment:

◆ “Installing a NetWorker virtual server” on page 97

◆ “Installing a virtual NetWorker Console server” on page 106

◆ “Installing only the NetWorker client software in a cluster” on page 108

Note: Do not relocate the NetWorker software. By default, the NetWorker is installed in the 
/usr directory.
EMC NetWorker Release 7.4 Service Pack 1 Multiplatform Version Cluster Installation Guide96



Sun Cluster Version 3.0 or 3.1 Installation
Installing a NetWorker virtual server

To install and configure the NetWorker software as a highly available service in a 
cluster, perform these tasks:

◆ “Task 1: Install the NetWorker software” on page 97

◆ “Task 2: Define the NetWorker server as highly available” on page 98

◆ “Task 3: Create an Instance of the NetWorker server resource group” on page 99

◆ “Task 4: (Optional) add a HAStoragePlus resource” on page 100

◆ “Task 5: Grant access to the highly available NetWorker server” on page 101

◆ “Task 6: Configure the NetWorker server” on page 103

◆ “Task 7: Configure clients under the NetWorker server” on page 103

◆ “Task 8: Create instances of the NetWorker Client resource type” on page 104

◆ “Task 9: Register licenses for the highly available NetWorker server” on page 105

◆ “Task 10: Authorize the software” on page 106

Task 1: Install the NetWorker software
The NetWorker software must be installed on all nodes in the cluster that are 
required to run the NetWorker resource group.

Note: Ensure that the following apply: 
- Solaris 8 operating environment and Sun Cluster 3.0 or 3.1 software are already installed on 
all nodes in the cluster and that those nodes boot in cluster mode.
- PATH environment variable includes /usr/sbin and /usr/cluster/bin.

To install the NetWorker software on nodes that will be running the NetWorker 
resource group:

1. Access the NetWorker software from the distribution media. The NetWorker 
Installation Guide provides installation instructions. 

2. Keep a copy of the current configuration. The NetWorker software installation 
script modifies the /etc/rpc and /etc/syslog.conf files during the installation 
process. 

Type these commands:

cp /etc/rpc /etc/rpc.old

cp /etc/syslog.conf /etc/syslog.conf.old

3. To install the software, type:

pkgadd -d .

4. Press Enter to install all of the packages on the server. Start the NetWorker 
daemons only after the last NetWorker package is installed.

Install selected software packages in this order: 

a. LGTOclnt (client software package)

b. LGTOnode (storage node software package)

c. LGTOserv (server software package)

d. LGTOman (optional man pages)
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5. Start the NetWorker daemons:

/etc/init.d/networker start

6. Type q to exit.

Note: Do not relocate the NetWorkersoftware. By default, the NetWorker is installed in the 
/usr directory.

Task 2: Define the NetWorker server as highly available
To define and configure the NetWorker server as highly available:

1. Log in as root.

2. Ensure that the /etc/hosts file on each cluster node contains the name of the 
logical host. The logical hostname can be published in the Domain Name System 
(DNS) or Network Information Services (NIS).

3. From each node in the cluster that will run the NetWorker server process:

a. Run the cluster configuration script networker.cluster located in /usr/sbin. 

This script defines the LGTOserv and the LGTOclnt resource types that the 
NetWorker software requires.

b. Type the information specified for each system prompt:

Enter directory where local NetWorker database is installed 
[/nsr]? 

– Type the location of the local NetWorker database directory provided 
during the installation procedure. For example: /space/nsr

Do you wish to configure for both NetWorker server and client?
Yes or No [Yes]? 

– Type Yes to configure the server software. This also installs the client 
software by default.

– Type No to configure only the client software.
Do you wish to add now the site-specific values for:
NSR_SHARED_DISK_DIR and NSR_SERVICE_ID 
Yes or No [Yes]?

– Type Yes to ensure compatibility with other cluster environments.
Enter the Logical Hostname to be used for NetWorker? 

– Type the published logical hostname to be used by the highly available 
NetWorker server. For example: clus_vir1

In what path will this nsr directory be created/located? 

– Type the pathname of the globally mounted /nsr directory that will 
contain the configuration information for the highly available NetWorker 
server. For example: /global/nw

Note: For more information, see “System information requirements” on page 95.
To undo any changes to the configuration, run the networker.cluster -r script and then 
run the networker.cluster script again.
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Task 3: Create an Instance of the NetWorker server resource group
A resource group must be created for the highly available NetWorker server. It must 
contain these resources:

◆ Logical hostname

◆ Globally mounted file system for the /nsr area

◆ LGTO.serv resource

◆ LGTO.clnt resource

◆ HAStoragePlus (optional)

To create an instance of the NetWorker Server resource group, perform these steps on 
one node in the cluster:

1. Create a resource group:

scrgadm -a -g networker

2. Add the logical host resource:

scrgadm -a -L -g networker -l clus_vir1

3. (Optional), create an instance of the SUNW.HAStoragePlus resource type:

a. Determine if the HAStoragePlus resource type is registered within the cluster:

scrgadm -p | egrep Type

b. If required, register the HAStoragePlus resource type within the cluster:

scrgadm -a -t SUNW.HAStoragePlus

c. Create the SUNW.HAStoragePlus resource:

scrgadm -a -g networker -j hastorageplus -t SUNW.HAStoragePlus \
-x FilesystemMountPoints=/global/clus_vir1/nw,/global/clus_vir1/
space
-x AffinityOn=True

Note: For more information on the SUNW.HAStoragePlus resource and the set up for 
locally mounted global systems, refer to the Sun Cluster 3.0 or 3.1 documentation.

4. Create an instance of the LGTO.clnt resource, type:

scrgadm -a -j client -t LGTO.clnt -g networker \
-x clientname=clus_vir1 \
-x owned_paths=/global/clus_vir1/nw,/global/clus_vir1/space

If the logical host resource name is different than the hostname it specifies, use 
this command to do the following:

a. Set the client name to the virtual hostname.

b. Set the optional network_resource property to the logical host resource name.

For example:

scrgadm -a -j client -t LGTO.clnt -g networker \
-x clientname=virtual_hostname -x network_resource=clus_vir1 \ 
-x owned_paths=/global/clus_vir1/nw,/global/clus_vir1/space 

5. Create an instance of the LGTO.serv resource type:

scrgadm -a -j server -t LGTO.serv -g networker \
-y network_resources_used=clus_vir1 \
-y Resource_dependencies=hastorageplus \
-x config_dir=/global/clus_vir1/nw
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If the logical host resource name is different than the hostname it specifies, set the 
optional servername property to the virtual hostname: 

scrgadm -a -j server -t LGTO.serv -g networker \ 
-y network_resources_used=clus_vir1 \ 
-x servername=virtual_hostname \ 
-x config_dir=/global/clus_vir1/nw 

Note: If you are using a HAStoragePlus resource, set resource_dependencies property to 
the HAStoragePlus resource name. 

6. Start the NetWorker resource group:

scswitch -Z -g networker

Example 1 A highly available NetWorker server

In this example, a highly available NetWorker server uses the logical hostname 
backup_server. The highly available NetWorker server uses /global/networker (globally 
mounted file system) as its configuration directory.

1. Create a resource group with the name backups:

scrgadm -a -g backups

2. Add the logical hostname resource type to the resource group created in the 
previous step:

scrgadm -a -L -g backups -l backup_server

3. Create an instance of the LGTO.serv resource type with the name networker_server. 
This resource belongs to the resource group backups and has a dependency on the 
logical host created in the previous step.

Specify the configuration directory on the globally mounted file system 
/global/networker:

scrgadm -a -j networker_server -t LGTO.serv -g backups \ 
-y network_resources_used=backup_server \
-x config_dir=/global/networker

4. The NetWorker logical host is also a client of the highly available NetWorker 
server. Create an instance of the LGTO.clnt resource type for the logical host 
backup_server within the resource group backups. The name of this resource is 
networker_client:

scrgadm -a -j networker_client -t LGTO.clnt -g backups \
-x clientname=backup_server -x owned_paths=/global/networker

5. Start the highly available service associated with the resource group backups.

scswitch -Z -g backups

Task 4: (Optional) add a HAStoragePlus resource

To add a SUNW.HAStoragePlus resource to an existing NetWorker server resource 
group: 

1. Determine whether the HAStoragePlus resource type is registered within the 
cluster:

scrgadm -p | egrep Type
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2. If required, register the HAStoragePlus resource type within the cluster:

scrgadm -a -t SUNW.HAStoragePlus

3. Create the SUNW.HAStoragePlus resource:

scrgadm -a -g networker -j hastorageplus -t SUNW.HAStoragePlus -x 
FilesystemMountPoints=/global/clus_vir1/nw,/global/clus_vir1/space 
-x AffinityOn=True

4. Enable the HAStoragePlus resource:

scswitch -e -j hastorageplus

5. Set up a dependency for the NetWorker Server resource on the HAStoragePlus 
resource:

scrgadm -c -j server -y Resource_Dependencies=hastorageplus

6. Verify that the resource dependencies are correctly set:

scrgadm -pvv -j server | egrep strong 

Task 5: Grant access to the highly available NetWorker server
Before a NetWorker server can back up a client, the client must grant the server 
access. Granting access is controlled by the servers file. For the node that is running 
the NetWorker Server resource group, this file is located in the globally mounted file 
system. Otherwise, this file is located on a local disk.

Note: If the /nsr/res/servers file is empty or does not exist, any NetWorker server is 
authorized to: 
- Access and back up the client.
- Perform a directed recovery to the client.

To grant access to the highly available NetWorker server:

1. On one node in the cluster:

a. Stop the NetWorker daemon by using the cluster management software, as 
follows:

scswitch -F -g NetWorker

b. Edit or create the servers file in the globally mounted /nsr area. For example, 
/global/nw/res/servers:

– Add the set of NetWorker servers, one per line, to be granted access to this 
client.

– Add an entry for the NetWorker logical hostname first. 
– Add entries for each physical host that can run the NetWorker resource 

group. 
For example:

clus_vir1

clus_phys1

clus_phys2

2. On each node in the cluster:

a. Shut down the NetWorker processes and verify that all NetWorker daemons 
have stopped:

nsr_shutdown
ps -ef | grep nsr
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b. Check the NetWorker boot-time startup file to see whether nsrexecd is being 
run with the -s option. 

If the -s option exists, remove all occurrences of -s servername in the file.

c. Edit or create the /nsr.NetWorker.local/res/servers file:

– Add the set of NetWorker servers, one per line, that require access to this 
client.

– Add an entry for the NetWorker logical hostname first. 
– Add entries for each physical host that can run the NetWorker resource 

group. 
For example:

clus_vir1

clus_phys1

clus_phys2

d. Restart the NetWorker processes:

/etc/init.d/networker start

3. On one node in the cluster, start the NetWorker daemon by using the cluster 
management software, as follows:

scswitch -Z -g NetWorker

4. If required, grant access to the NetWorker virtual server on clients outside of the 
cluster:

On each client that is outside of the cluster:

a. To shut down the NetWorker processes, type: 

nsr_shutdown

b. To verify that all NetWorker daemons have stopped, type:

ps -ef |grep nsr

c. Edit or create the /nsr/res/servers file:

– Add the set of NetWorker servers, one per line, that require access to this 
client.

– Add an entry for the NetWorker logical hostname first. 
– Add entries for each physical host that can run the NetWorker resource 

group. 
For example:

clus_vir1

clus_phys1

clus_phys2

d. Type this command to restart the NetWorker daemons:

/etc/init.d/networker start
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Task 6: Configure the NetWorker server
To configure the NetWorker server:

1. Log in as root on the cluster node that is currently running the NetWorker server 
resource group.

2. Start the NetWorker Console software.

3. From the Administration window, select Properties from the File menu.

a. For the Administrator attribute, add entries for any cluster nodes that are not 
already listed. For example:

root@hostname

b. Click OK.

Task 7: Configure clients under the NetWorker server
When the networker.cluster script runs, it creates a symbolic link named /nsr that 
points to a local disk. It also creates a second link named nsr.NetWorker.local that 
points to the local NetWorker directory. For example, if the local NetWorker 
directory was created in /var/nsr, each client member has these links:

◆ /nsr->/nsr.NetWorker.local

◆ /nsr.NetWorker.local->/var/nsr

To configure each client under the NetWorker server:

1. (Optional) Define save groups.

Note: In order for their save sets to restart after a virtual client or NetWorker server 
failover, save groups must have the Autorestart attribute enabled and the Manual Restart 
option disabled.

2. Make each physical client within the cluster a client of the NetWorker server. For 
each physical client in the cluster:

a. Create a new client.

b. Type the name of the physical client for the Name attribute.

3. Make each virtual client within the cluster a client of the virtual NetWorker 
server. For each virtual client in the cluster:

a. Create a new NetWorker client.

b. For the Name attribute, type the name of the virtual client.

c. In the Remote Access attribute, add entries for each physical client within the 
cluster. For example:

root@clus_phys1

d. For the Group attribute, select a group.

4. Run a test probe to verify that the Client resource and the Group resource have 
been properly configured.

Type this command on the node on which the NetWorker server resides:

savegrp -pv -c client_name group_name

If the test probe does not display the correct scheduled backups and index, refer 
to the EMC NetWorker Administration Guide.
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Task 8: Create instances of the NetWorker Client resource type
An instance of the NetWorker Client resource type must be created for each virtual 
client that accesses data on globally mounted file systems. Virtual clients in Sun 
Cluster 3.0 and 3.1 are either logical hostnames or shared addresses. 

Note: All globally mounted file systems (except the /global/.devices/... file systems) must be 
owned by a resource group and defined in a NetWorker Client resource type. If the file 
systems are not properly configured, multiple copies will be backed up for each cluster node. 

To back up the data for a virtual client: 

1. Create an instance of the NetWorker Client resource as part of an existing 
resource group that contains a logical host or shared addresses. For example:

scrgadm -a -j resource_name -g resource_group_name -t LGTO.clnt \ 
-x clientname=virtual_hostname -x owned_paths=pathname_1, 

pathname_2[,...]

The virtual_hostname variable is a hostname specified by a logical hostname or 
Shared Address resource. By default, the logical hostname or shared address 
resource name is the same as the first hostname in the list of hostnames the 
resource controls. 

If the logical hostname or shared address resource was explicitly named, set the 
optional network_resource property to the resource name:

scrgadm -a -j resource_name -g resource_group_name -t LGTO.clnt\

-x clientname=virtual_hostname 

-x network_resource=logicalhostname_ 
or_SharedAddress_resource_name \

-x owned_paths=pathname_1, pathname_2[,...]

These examples provide more information:

• “A highly available Informix database server” on page 104

• “A scalable Apache web server” on page 105

2. Run a test probe to verify that the Client and Group resources are properly 
configured.

Type this command on the node on which the NetWorker server resides:

savegrp -pv -c client_name savegroup_name

If the test probe does not display the scheduled backups and index, refer to the 
NetWorker Administration Guide.

Example 2 A highly available Informix database server 

In this example, the Informix database server is configured to use the DNS registered 
hostname informix_lhrs. An existing failover resource group named informix_rg 
contains a:

◆ SUNW.informix resource named informix_res 

◆ SUNW.LogicalHostname resource named informix_lhrs

This SUNW.informix database server can access data on a global file system under 
/global/informix/config and /global/informix/db.
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To add a NetWorker virtual client to the existing resource group informix_rg, 
type:

scrgadm -a -j informix_clntrs -g informix_rg -t LGTO.clnt \
-x clientname=informix_lhrs \
-x owned_paths=/global/informix/config,/global/informix/db

Example 3 A scalable Apache web server

In this example, an Apache web server is configured to use the DNS registered 
hostname apache_sars. An existing scalable resource group named apache_rg 
contains a:

◆ SUNW.apache resource named apache_res 

◆ SUNW.SharedAddress resource named apache_sars

This Apache web server accesses data on a global file system under 
/global/web/config and /global/web/data. 

To add a NetWorker virtual client to the existing resource group apache_rg, type:

scrgadm -a -j apache_clntrs -g apache_rg -t LGTO.clnt \
-x clientname=apache_sars \
-x owned_paths=/global/web/config,/global/web/data

Task 9: Register licenses for the highly available NetWorker server
To register and license the highly available NetWorker server:

1. Order licenses for the type of NetWorker server and client configuration in use. 

2. Log in to the system that is currently running the NetWorker resource group. 

3. Perform these operations to enter the purchased enabler codes:

a. If you have been evaluating the NetWorker highly available software and 
have now purchased the software:

– To upgrade from the base evaluation enabler to the purchased enabler, 
type:
nsrcap -v -u base_enabler_code

– Delete any remaining evaluation enablers:
nsradmin -s clus_vir1

This eliminates warning messages due to expiring evaluation enablers. 

b. For each enabler code, type:

nsrcap -v -c enabler_code

4. Ensure that the highly available NetWorker server is defined as a part of the 
cluster.

5. Run the following command, and capture the output, on each node that is 
currently running the NetWorker server resource group:

hostid

The numeric identifier of the current host prints.

6. Log in to the system that is running the NetWorker virtual server and create the 
/nsr/res/hostids file. This file contains the host IDs of all the cluster nodes. 

Use this syntax:

hostid1:hostid2:hostid3:... 
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For example:

12345678:87654321

7. Type the following commands to restart the server by taking the highly available 
NetWorker server offline and then putting it back online:

scswitch -F -g NetWorker

scswitch -Z -g NetWorker

8. On one node in the cluster:

a. Start the NetWorker Console. Use the logical hostname for the highly 
available NetWorker server.

b. From the NetWorker Administration window, note the host ID number for 
the appropriate cluster license.

c. Register the NetWorker software.

Note: Do not change the logical hostname for the highly available NetWorker server. If you 
change it after you update the software, you must permanently license and authorize the 
highly available NetWorker server.

Task 10: Authorize the software
To enter the permanent authorization code for NetWorker servers and clients: 

1. On one node in the cluster, start the NetWorker Console. Use the logical 
hostname for the highly available NetWorker server.

2. Complete the customer information and contact information fields:

a. Start the NetWorker Console software.

b. From the Administration window, click Configuration.

c. In the left pane, select the NetWorker server.

d. From the File menu, select Properties. The Properties dialog box appears.

e. Select the Customer Information tab and complete your contact information.

f. Click Ok.

3. Review the registration information:

a. From the Administration window, click Configuration.

b. In the left pane, click Registration.

c. In the right pane, right-click the license to be authorized, then select 
Properties. The Properties dialog box appears.

d. Review the Auth Code attribute.

Installing a virtual NetWorker Console server
To install and configure the NetWorker Console server as a highly available service 
in a cluster, read and follow the procedures for these tasks:

◆ “Task 1: Install the NetWorker Management software in a cluster” on page 107

◆ “Task 2: Define the NetWorker Management server as highly available” on 
page 107
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Task 1: Install the NetWorker Management software in a cluster
To install the NetWorker software on each node in the cluster:

1. Ensure that the most recent cluster patch for the operating system is installed.

2. Install the NetWorker Console server software (LGTOnmc) on each node in the 
cluster.

The NetWorker Installation Guide provides instructions.

Task 2: Define the NetWorker Management server as highly available
To define and configure NetWorker server as a highly available application:

1. From each node in the cluster:

a. Log in as root.

b. Ensure that the /etc/hosts file on each cluster node contains the name of the 
logical host. The logical hostname can be published in the Domain Name 
System (DNS) or Network Information Services (NIS).

2. From each node in the cluster that will run the NetWorker server process:

a. Run the cluster configuration script gst_ha.cluster located in 
/opt/LGTOnmc/bin/nsr. 

This script defines the GST_HA.serv resource type that the NetWorker 
Console server requires. 

Note: When running the gst_ha.cluster script, ensure that you use the same values for 
logical hostname and for the global mounted path for all node in the cluster.

./gst_ha.cluster

NMC Console Server is in the process of being made a Highly 
Available application within Sun Cluster 
3.1.0,REV=2003.03.24.14.50.

To complete this task, the following are required.

A Logical host or virtual IP for the Console Server A globally 
mounted dir for the LGTOnmc database.

A GST_HA.serv resource type will be created via this process and 
will be needed to configure NMC as a Highly Available 
Application within Sun Cluster 3.1.0,REV=2003.03.24.14.50.

Do you wish to continue? [Yes]?

Restarting syslog daemon...

Please enter Logical Hostname to be used by NMC server? hunt

Is the Logical Hostname entered correct (y/n)? y

The lgto_gstdb database should be on a globally mounted 
filesystem which can be accessible by the cluster nodes which 
will host the Highly Available NMC server.

Please enter the globally mounted shared directory for the 
lgto_gstdb database (/global/logicalhost)? /global/hunt/data1

Is the shared directory path entered for the lgto_gstdb database 
correct (y/n)? y

Moving /bigspace/lgto_gstdb local gstdb directory to globally 
mounted /global/hunt/data1/lgto_gstdb Resource type GST_HA.serv 
is not registered Defining GST_HA.serv resource type with RGM.

NMC has been successfully cluster-configured.
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b. Ensure that the GST_HA.serv resource type was created. 

scrgadm -pv -t GST_HA.serv

Res Type name: GST_HA.serv

GST_HA.serv) Res Type description: NMC Server for Sun Cluster

GST_HA.serv) Res Type base directory: /opt/LGTOnmc/bin

GST_HA.serv) Res Type single instance: False

GST_HA.serv) Res Type init nodes: All potential masters

(GST_HA.serv) Res Type failover: False

(GST_HA.serv) Res Type version: (GST_HA.serv) 

Res Type API version: 2

(GST_HA.serv) Res Type installed on nodes: <All>

(GST_HA.serv) Res Type packages: <NULL>

Note: To undo any changes to the configuration, run the gst_ha.cluster -r script and 
then run the gst_ha.cluster script again.

3. From one node in the cluster:

a. Create a resource group named "nmc":

scrgadm -a -g nmc

b. Create a logical hostname resource: For example:

scrgadm -a -L -g nmc -l logical_hostname

c. Create an nmc server resource instance. For example:

scrgadm -a -j nmc_server_name -t GST_HA.serv -g nmc 
-y network_resources_used=logical_hostname 
-x database_dir=database_dir

Installing only the NetWorker client software in a cluster
In this configuration, the NetWorker server is running on a node that is not a member 
of the cluster.

To install a NetWorker cluster client, perform these tasks:

◆ “Task 1: Install the NetWorker software” on page 97

◆ “Task 2: Configure NetWorker client software as highly available” on page 109

◆ “Task 3: Create instances of the Client resource type” on page 110

◆ “Task 4: Define the list of trusted NetWorker servers” on page 111

◆ “Task 5: Configure clients under the NetWorker server” on page 111

Note: Ensure that the NetWorker client software is installed on each node in the cluster. Do not 
relocate the NetWorker software. By default, the NetWorker is installed in the /usr directory.
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Task 1: Install the NetWorker cluster client software

Note: Ensure that the Solaris 8 operating environment and Sun Cluster 3.0 or 3.1 software are 
already installed on all cluster nodes and that those nodes boot in cluster mode. Also, ensure 
that the PATH environment variable includes /usr/sbin and /usr/cluster/bin.

To install the NetWorker software on the computer that is designated as the 
NetWorker client:

1. Access the NetWorker software from the distribution media. The NetWorker 
Installation Guide provides installation instructions.

2. Type the pkgadd -d . command:

Note: Do not press the Enter key for the default response All. Accepting the default installs 
the server package.

3. Type the appropriate option number to install the client package (LGTOclnt).

4. (Optional) Type the appropriate option number to install the man pages, 
(LGTOman).

5. Type this command to start the NetWorker daemons:

/etc/init.d/networker start

6. When all the applicable packages have been added, and the prompt appears, type 
q to exit.

Task 2: Configure NetWorker client software as highly available
To define and configure a NetWorker client as highly available:

1. Log in as root on each node where the NetWorker software is being installed.

2. Ensure that the /etc/hosts file on each cluster node contains the name of the 
virtual host. The virtual hostname can be published in the DNS or NIS.

3. For each node in the cluster:

a. Run the cluster configuration script, /usr/sbin/networker.cluster. 

This script defines the LGTO.clnt resource types that the NetWorker software 
requires.

b. In response to the prompts, type the appropriate response::

Enter directory where local NetWorker database is installed 
[/nsr]? 

– Type the location of the local NetWorker database directory is provided 
during the installation procedure. For example: /space/nsr.

Do you wish to configure for both NetWorker server and client? 
Yes or No [Yes]? 

– Type No. This configures only the client software.

Note: Any changes to the configuration can be undone by running the 
networker.cluster -r option and then running the networker.cluster script again. 
For information, see “System information requirements” on page 95.
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Task 3: Create instances of the Client resource type
An instance of the NetWorker Client resource type must be created for each virtual 
client that accesses data on globally mounted file systems. Virtual clients in Sun 
Cluster 3.0 and 3.1 are either logical hostnames or shared addresses. 

Note: All globally mounted file systems (except the /global/.devices/... file systems) must be 
owned by a logical host and defined in a NetWorker Client resource type. If the file systems are 
not properly configured, multiple copies will be backed up for each cluster node.

To back up the data for a virtual client, from any node in the cluster, create an 
instance of the NetWorker Client resource as part of an existing resource group that 
contains a logical host or shared address. For example:

scrgadm -a -j resource_name -g resource_group_name -t LGTO.clnt \
-x clientname=virtual_hostname -x owned_paths=pathname_1, 

pathname_2[,...]

Example 4 A highly available Informix database server 

In this example, the Informix database server is configured to use the DNS registered 
hostname informix_lhrs. 

An existing failover resource group named informix_rg contains a:

◆ SUNW.informix resource named informix_res 

◆ SUNW.LogicalHostname resource named informix_lhrs

This SUNW.informix database server can access data on a global file system under 
/global/informix/config and /global/informix/db.

To add a NetWorker virtual client to the existing resource group informix_rg, type:

scrgadm -a -j informix_clntrs -g informix_rg -t LGTO.clnt \
-x clientname=informix_lhrs \
-x owned_paths=/global/informix/config,/global/informix/db

Example 5 A scalable Apache web server

In this example, an Apache web server is configured to use the DNS registered 
hostname apache_sars. An existing scalable resource group named apache_rg contains 
a:

◆ SUNW.apache resource named apache_res 

◆ SUNW.SharedAddress resource named apache_sars

This Apache web server accesses data on a global file system under 
/global/web/config and /global/web/data. 

To add a NetWorker virtual client to the existing resource group apache_rg, type:

scrgadm -a -j apache_clntrs -g apache_rg -t LGTO.clnt \
-x clientname=apache_sars \
-x owned_paths=/global/web/config,/global/web/data
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Task 4: Define the list of trusted NetWorker servers
Before a NetWorker server can back up a client, the client must grant the server 
access. Granting access is controlled by the servers file. For the node that is currently 
running the NetWorker Server resource group, this file is located in the globally 
mounted file system. Otherwise, this file is located on a local disk. 

Note: If the /nsr/res/servers file is empty or does not exist, any NetWorker server is authorized 
to: 
- Access and back up the client.
- Perform a directed recovery to the client.

To define the list of trusted NetWorker servers, perform these steps on each node in 
the cluster:

1. Shut down the NetWorker processes and verify that all NetWorker daemons 
have stopped:

nsr_shutdown
ps -ef |grep nsr

2. Edit or create the /nsr/res/servers file and add the set of NetWorker servers, one 
per line, that require access to this client.

3. Check the NetWorker boot-time startup file to see whether nsrexecd is being run 
with the -s option. If the -s option exists, remove all occurrences of the following 
in the file: 

-s servername 

4. Restart the NetWorker daemons:

/etc/init.d/networker start

Task 5: Configure clients under the NetWorker server
To configure the NetWorker server:

1. Make each physical client within the cluster a client of the NetWorker server. For 
each physical client in the cluster:

a. Create a new client.

b. For the Name attribute, type the name of the physical client.

Note: If a physical client is backed up to a NetWorker server outside the cluster, the name 
of any virtual service that can run on the physical node must be added to the Remote 
Access list of the physical Client resource.

2. Make each virtual client within the cluster a client of the NetWorker server.

For each virtual client in the cluster:

a. Create a new client.

b. For the Name attribute, type the name of the NetWorker server.

c. For the Remote Access attribute, add entries for each physical client within 
the cluster. For example:

root@clus_phys1

d. For the Group attribute, select a group.

3. Schedule backups by using the NetWorker application. 

Note: The NetWorker server might reside outside of the cluster. 
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Uninstalling the NetWorker software
To uninstall the NetWorker software from a cluster environment: 

1. On one node in the cluster, disable and remove all instances of the LGTO.serv 
and LGTO.clnt resource types in the cluster. 

For information, refer to the scswitch(1m) and scrgadm(1m) man pages.

2. On each node in the cluster:

a. Log in as root on the computer that the software is being removed.

b. Undo all changes to the configuration by running the networker.cluster -r 
option.

c. To shut down the NetWorker daemons, type:

nsr_shutdown

Note: Remove the NetWorker software packages in this order:
- LGTOserv
- LGTOnode
- LGTOnmc
- LGTOclnt

The man pages (LGTOman) and document files have no dependencies and 
can be removed at any time.

d. To remove all the packages, type:

pkgrm LGTOserv LGTOnode LGTOnmc LGTOclnt LGTOlic LGTOman

Configuring an external client to a virtual server
Use this procedure to configure and back up an external NetWorker client to a highly 
available NetWorker server. Before a NetWorker server can back up a client, the 
client must grant the server access. Granting access is controlled by the servers file. If 
the servers file does not exist, any NetWorker server can back up this client. If the 
servers file does exist, only the specific servers listed in the file can back up the client.

On each NetWorker client that is outside of the cluster:

1. Shut down the NetWorker processes:

nsr_shutdown

2. Verify that all NetWorker daemons have stopped:

ps -ef |grep nsr

3. Edit or create the /nsr/res/servers file:

a. Add the set of NetWorker servers, one per line, that require access to this 
client.

b. Add an entry for the NetWorker logical hostname first. Then add entries for 
each physical host that can run the NetWorker resource group. For example:

– clus_vir1
– clus_phys1
– clus_phys2
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Defining ownership of a raw partition for virtual clients
To back up the raw partitions of a NetWorker virtual client, ensure that the raw 
device path appears in the owned paths field of the LGTO.clnt resource. 

Example 6 A highly available web server

In this example, a highly available web server uses the shared address web_server. 
The web server services are placed under the control of the apache_rg resource 
group. The services access files that are kept in two separate globally mounted file 
systems: /global/web/config and /global/web/data. The web server also accesses 
the raw partition /dev/md/hunt/rdsk/d30.

To create the NetWorker Client resource named apache_nw, type: 

scrgadm -a -j apache_nw -g apache_rg -t LGTO.clnt
-x clientname=web_server \
-x owned_paths=/global/web/config,/global/web/data,

/dev/md/hunt/rdsk/d30

For information on backing up raw partitions, refer to the rawasm command as 
described in the uasm(1m) man page.
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Software installation roadmap
Use the following roadmap to follow when installing NetWorker software:

1. Review “Installation requirements” on page 116 and note the default directory 
location.

2. If you are updating from an earlier release of NetWorker software follow the 
procedures in “Updating from a highly available NetWorker server” on page 118. 

3. Install the required NetWorker software by following “Installing NetWorker 
software as highly available” on page 120.

4. Enable and register all of the NetWorker products. Chapter 10, ”Licensing and 
Enabling the Software,” provides detailed information.

Installation requirements
This section specifies the software and hardware required to install and configure the 
NetWorker server or client software within an HP Tru64 UNIX TruCluster 
environment:

The EMC Information Protection Software Compatibility Guide provides the most 
up-to-date information about software and hardware requirements.

Ensure that the most current software patches are installed. For further information 
regarding the latest Tru64 UNIX and TruCluster Server software patches, refer to the 
Hewlett-Packard website.

Software requirements

The following software must be installed on each node in the cluster:

◆ HP Tru64 UNIX Version 5.1B-3 or later

◆ NetWorker release 7.3 or later

◆ Latest NetWorker patch

◆ Latest TruCluster Server and Tru64 UNIX patches

Hardware requirements

The following hardware requirements must be met:

◆ Dedicated disk to be used as the NetWorker storage disk (for the /nsr directory) 
connected to a shared SCSI bus for NetWorker indexes.

◆ Shared tape devices.

To install the NetWorker software, ensure that the following hardware requirements 
are met for server installation only:

◆ Dedicated shared disk that is to be used as the NetWorker storage disk (for the 
/nsr directory) that is connected to all the nodes within the cluster.

◆ Each physical node of the cluster on which the virtual server can run must have a 
storage device with local affinity attached. The EMC NetWorker Administration 
Guide provides more information about storage devices in a cluster.
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Note: Do not use file type devices on shared file systems as permanent storage for the server 
bootstrap records.

System information requirements
Figure 6 on page 117 and Table 19 on page 117 display the system information that is 
needed to install NetWorker software within an HP Tru64 UNIX TruCluster 
environment.

Figure 6 Sample cluster configuration

Different operating systems use different terms for the same cluster concepts. 
TruCluster refers to physical hosts as members.

Table 19 Required information

 Information required Example

Cluster default alias and its corresponding IP address clus_vir1, 192.168.99.31

Media changer (if required) /dev/changer/mc0

Tape, one or more devices /dev/ntape/tape0_d1

Mount point for NetWorker server databases /cluster_default_alias

Local
Disk 1

Cluster

Shared Disks 3

Node 2
nodename: right

Boot Address: right_svc

Node 1
nodename: left

Boot Address: left_svc

Local
Disk 2

Public NetWork

NetWorker Virtual Server
Service Address: clus_vir1

(If Node 1 fails, 
clus_vir1 fails 

over to Node 2)

Private Network
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Updating from a highly available NetWorker server
Use the following roadmap to update the NetWorker software:

◆ “Task 1: Store NetWorker profiles” on page 118

◆ “Task 2: Remove the NetWorker cluster configuration” on page 118

◆ “Task 3: Remove the existing NetWorker software” on page 119

◆ “Task 4: Install the updated NetWorker software” on page 119

◆ “Task 5: Run the networker.cluster script” on page 119

◆ “Task 6: Disable strong authentication for each NetWorker client” on page 119

◆ “Task 7: Disable strong authentication for the NetWorker server” on page 120

◆ “Task 8: Register NetWorker licenses for cluster server failover” on page 120

Task 1: Store NetWorker profiles
If a highly available server that is running NetWorker release 6.0 or later exists on 
TruCluster 5.x, save the current NetWorker cluster profile with any customizations 
before updating to release 7.3 of the NetWorker software. 

The contents of the NetWorker cluster action script, and the NetWorker cluster 
profile, might be deleted when uninstalling an earlier release of the NetWorker 
software.

To store the NetWorker profiles:

1. Shut down the NetWorker services and make a backup copy of the Cluster 
Applications Availability (CAA) script profiles for NetWorker software: 

caa_stop networker

cp /var/cluster/caa/profile/networker.cap /tmp

2. Save a copy of the following files:

• /var/cluster/caa/script/networker.scr

• /var/cluster/caa/profile/networker.cap

3. Unregister NetWorker software from CAA. For example:

caa_unregister networker

Task 2: Remove the NetWorker cluster configuration 
On each node in the cluster:

1. Remove the NetWorker server cluster configuration files.

/usr/opt/networker/bin/networker.cluster -r

2. ***In response to the following networker.cluster prompt, select No:

% This node was removed from the cluster configuration.
% A cluster configuration removal will follow.
Do you wish to continue [No]? No

3. Remove the /nsr Context Dependent Symbolic Link (CDSL) from the cluster file 
system:

rm /nsr
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Task 3: Remove the existing NetWorker software

The NetWorker Installation Guide provides instructions on how to remove the 
existing NetWorker software.

Task 4: Install the updated NetWorker software

Install the updated NetWorker software on each node in the cluster: 

◆ Client

◆ Storage node 

◆ Server

“Installing NetWorker software as highly available” on page 120 provides 
instructions on installing NetWorker as a highly available application.

Task 5: Run the networker.cluster script

For each node in the cluster run the networker.cluster script:

/usr/opt/networker/bin/networker.cluster

Task 6: Disable strong authentication for each NetWorker client

On each node in the cluster:

1. Use the kill <pid> command to manually kill the nsrexecd daemon:

ps -ef | grep nsrexecd | grep -v grep

kill -9 <pid>

Note: Do not use the nsr_shutdown command.

2. Restart the nsrexecd daemon:

/usr/opt/networker/bin/nsrexecd

3. Disable strong authentication for each NetWorker client:

/usr/opt/networker/bin/nsradmin -p nsrexecd

nsradmin> . type: NSRLA

Current query set

nsradmin> update auth methods: "0.0.0.0/0,oldauth" 

Update? y

updated resource id 3.0.80.79.183.75.167.67.10.0.0.2(6)

nsradmin> q

4. Restart the nsrexecd daemon:

/usr/opt/networker/bin/nsr_shutdown -f

/usr/opt/networker/bin/nsrexecd
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Task 7: Disable strong authentication for the NetWorker server

On one node in the cluster:

1. Register the NetWorker software with CAA:

caa_register networker

2. Retrieve the saved NetWorker profiles from “Task 1: Store NetWorker profiles” on 
page 118. For example:

cp /tmp/networker.cap /var/cluster/caa/profile

3. Start the NetWorker resource group:

caa_start -c firstnode networker

4. From the node that is running the NetWorker server:

a. Disable strong authentication:

/usr/opt/networker/bin/nsradmin -p nsrexecd

nsradmin> . type: NSRLA

Current query set

nsradmin> update auth methods: "0.0.0.0/0,oldauth" 

Update? y

updated resource id 3.0.80.79.183.75.167.67.10.0.0.2(6)

nsradmin> q

b. Restart the NetWorker resource group:

caa_stop networker

caa_start networker

Task 8: Register NetWorker licenses for cluster server failover
Locate the composite hostid from the Registration window in the NetWorker 
Administrator program. Contact Product Licensing to obtain an update authorization 
code. Chapter 10, ”Licensing and Enabling the Software,” provides details.

The EMC NetWorker Administration Guide provides details about NetWorker cluster 
licensing.

Installing NetWorker software as highly available
Use this roadmap when installing NetWorker software as a highly available application: 

◆ “Task 1: Check for previously installed NetWorker packages” on page 121

◆ “Task 2: Install the NetWorker software within a cluster” on page 121

◆ “Task 3: Define the list of trusted NetWorker servers” on page 125

◆ “Task 4: Configure the NetWorker cluster server” on page 126

◆ “Task 5: Configure the cluster to back up itself” on page 126

◆ “Task 6: Configure cluster clients to a remote NetWorker server” on page 127

◆ “Task 7: Register NetWorker licenses for cluster server failover” on page 127
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Note: The NetWorker release 5.5.2 server is not supported on TruCluster Server Version 5.1B-3 
or later. Do not upgrade or migrate to a NetWorker release 6.0 or later server.

Task 1: Check for previously installed NetWorker packages
If a previous version of NetWorker software is installed on the system, it will 
interfere with the installation of new NetWorker packages.

Before installing the NetWorker software, perform one of the following: 

◆ Remove any previously installed NetWorker packages on a cluster node. For 
example, use the following setld -i and grep commands as root user:

setld -i | grep -E LGTO

◆ As root user, type the following command to remove all existing NetWorker 
packages on the system:

setld -d subset_names

NetWorker software packages have dependencies and must be removed in this order:

1. Server

2. Storage node

3. Client

The man page packages have no dependencies and can be removed or installed at 
any time.

Task 2: Install the NetWorker software within a cluster
To install the NetWorker software within a cluster, see one of the following sections:

◆ “Installing the client software” on page 121

◆ “Installing the storage node software” on page 122

◆ “Installing the server software” on page 123

If a file system for the NetWorker database is being created, set the following mount 
point before installing the NetWorker software. This allows for neater system 
administration: 

/cluster_default_alias

Note: If the NetWorker file system is mounted under /cluster_default_alias/nsr, the 
NetWorker uninstall procedure will fail.

Installing the client software
You can choose to install only the client software within the TruCluster Server 
environment. 

To install only the client software:

1. Log in as root on the system where the NetWorker software is being installed.

2. Change directories to the location of the NetWorker software distribution files:

• To change from a local or remote CD-ROM, mount the CD-ROM and then 
change directories to where it is mounted.

• To change from a downloaded web file, change to the directory where the 
installation files were extracted from the downloaded package.
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3. Type the following command to install the appropriate NetWorker subsets:

setld -l path_name

4. When the NetWorker software subsets appear, select only the client software for 
installation. 

Note: Type /nsr when prompted to type the location of the client’s NetWorker home 
directory on the local disk. If any other path is entered, /nsr will be created as a symbolic 
link and will cause the cluster configuration to fail.

5. On each node in the cluster:

a. Run the following script:

/usr/opt/networker/bin/networker.cluster

b. Use the kill <pid> command to manually kill the nsrexecd daemon. For 
example:

ps -ef | grep nsrexecd | grep -v grep

kill -9 <pid>

Note: Do not use the nsr_shutdown command for this step.

c. Restart the nsrexecd daemon:

/usr/opt/networker/bin/nsrexecd

d. Disable strong authentication:

/usr/opt/networker/bin/nsradmin -p nsrexecd

nsradmin> . type: NSRLA

Current query set

nsradmin> update auth methods: "0.0.0.0/0,oldauth" 

Update? y

updated resource id 3.0.80.79.183.75.167.67.10.0.0.2(6)

nsradmin> q

e. Restart the nsrexecd daemon:

/usr/opt/networker/bin/nsr_shutdown -f

/usr/opt/networker/bin/nsrexecd

Installing the storage node software
Virtual storage nodes on a cluster with failover capability and the NetWorker server 
outside of the cluster, are not supported. However, a single storage node (physical, 
not virtual) on a cluster node for a NetWorker server outside the cluster is supported. 

To install the storage node software:

1. Log in as root on the computer where the NetWorker software is being installed.

2. Change directories to the location of the NetWorker software distribution files:

• To change from a local or remote CD-ROM, mount the CD-ROM and then 
change directories to where it is mounted.

• To change from a downloaded web file, change to the directory where the 
installation files were extracted from the downloaded package.
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3. Type the following command to install the appropriate NetWorker subsets:

setld -l path_name

4. When the NetWorker software subsets appear, select these additional subsets:

• Client

• Storage node

5. On each node in the cluster:

a. Run the following script:

/usr/opt/networker/bin/networker.cluster

b. Use the kill <pid> command to manually kill the nsrexecd daemon. For 
example:

ps -ef | grep nsrexecd | grep -v grep
kill -9 <pid>

Note: Do not use the nsr_shutdown command.

c. Restart the nsrexecd daemon:

/usr/opt/networker/bin/nsrexecd

d. Disable strong authentication:

/usr/opt/networker/bin/nsradmin -p nsrexecd
nsradmin> . type: NSRLA

Current query set

nsradmin> update auth methods: "0.0.0.0/0,oldauth" 
Update? y
updated resource id 3.0.80.79.183.75.167.67.10.0.0.2(6)
nsradmin> q

e. Restart the nsrexecd daemon:

/usr/opt/networker/bin/nsr_shutdown -f
/usr/opt/networker/bin/nsrexecd

Installing the server software
To install the server software:

1. Log in as root on the system where the NetWorker software is being installed.

2. Change directories to the location of the NetWorker software distribution files:

• To change from a local or remote CD-ROM, mount the CD-ROM and then 
change directories to where it is mounted.

• To change from a downloaded web file, change to the directory where the 
installation files were extracted from the downloaded package.

3. Type the following command to install the appropriate NetWorker subsets:

setld -l path_name

4. When the NetWorker software subsets appear, select these additional subsets:

• Client

• Drive and storage node

• Server

• Man pages (optional)
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5. On each node in the cluster:

a. Run the following script:

/usr/opt/networker/bin/networker.cluster

b. Use the kill <pid> command to manually kill the nsrexecd daemon. For 
example:

ps -ef | grep nsrexecd | grep -v grep

kill -9 <pid>

Note: Do not use the nsr_shutdown command for this step.

c. Restart the nsrexecd daemon:

/usr/opt/networker/bin/nsrexecd

d. Disable strong authentication:

/usr/opt/networker/bin/nsradmin -p nsrexecd

nsradmin> . type: NSRLA

Current query set

nsradmin> update auth methods: "0.0.0.0/0,oldauth" 

Update? y

updated resource id 3.0.80.79.183.75.167.67.10.0.0.2(6)

nsradmin> q

e. Restart the nsrexecd daemon:

/usr/opt/networker/bin/nsr_shutdown -f

/usr/opt/networker/bin/nsrexecd

6. On one node in the cluster:

a. Register the NetWorker software with CAA:

caa_register networker

b. Start the NetWorker resource group:

caa_start -c firstnode networker

7. From the node that is running the NetWorker server:

a. Disable strong authentication:

/usr/opt/networker/bin/nsradmin -p nsrexecd

nsradmin> . type: NSRLA

Current query set

nsradmin> update auth methods: "0.0.0.0/0,oldauth" 

Update? y

updated resource id 3.0.80.79.183.75.167.67.10.0.0.2(6)

nsradmin> q

b. Restart the NetWorker resource group:

caa_stop networker

caa_start networker
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Task 3: Define the list of trusted NetWorker servers

To define the list of trusted NetWorker servers:

1. On one node in the cluster, shut down the NetWorker service by using the cluster 
management software.

2. On each node in the cluster:

a. Edit or create the /nsr/res/servers file and add the set of NetWorker servers, 
one per line, that require access to this client.

b. Ensure that the first entry in this file is the virtual hostname for the NetWorker 
service. This entry becomes the default NetWorker server.

Note: If the /nsr/res/servers file is empty or does not exist, any NetWorker server is 
authorized to: 
- Access and back up the client.
- Perform a directed recovery to the client.

3. Check the NetWorker boot-time startup file for nsrexecd -s arguments. If they 
exist, delete the -s arguments. The nsrexecd -s argument supersedes the 
/nsr/res/servers file. 

For example, delete the arguments for nsrexecd -s in the following file:

vi /sbin/init.d/NSRstartstop

nsrexecd -s venus -s mars

The nsrexecd daemon named in the file should appear only as:

nsrexecd

4. Use the NetWorker boot-time startup file to stop and restart the NetWorker 
software:

/sbin/init.d/NSRstartstop stop

/sbin/init.d/NSRstartstop start

5. On one node in the cluster, start the NetWorker service by using the cluster 
management software.

6. On the node that is running the NetWorker server:

a. Edit or create the /nsr/res/servers file and add the set of NetWorker servers, 
one per line, that require access to this client.

Note: Ensure that the first entry in this file is the virtual hostname for the NetWorker 
service. This entry becomes the default NetWorker server.

b. Shut down and restart the NetWorker service by using the cluster 
management software.
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Task 4: Configure the NetWorker cluster server

After the NetWorker software is installed on the cluster nodes, complete the 
installation by configuring the NetWorker server. 

To configure the NetWorker server within the cluster:

1. Log in as root on the cluster node that is running the NetWorker virtual server 
and start the NetWorker software:

/usr/opt/networker/bin/nsradmin -s clus_vir1

2. From the Administration window, select Properties from the File menu.

3. For the Administrator attribute, add entries for any cluster nodes that are not 
already listed. For example: 

root@hostname

4. Click OK.

Task 5: Configure the cluster to back up itself 

To configure the cluster client to back up itself:

1. (Optional) Define save groups.

Note: In order for their save sets to restart after a virtual client or NetWorker server 
failover, save groups must have the Autorestart attribute enabled and the Manual Restart 
option disabled.

2. Make each physical client within the cluster a client of the NetWorker server. For 
each physical client in the cluster:

a. Create a new client.

b. For the Name attribute, type the name of the physical client.

The NetWorker cluster server will take the identity of the cluster’s default 
alias regardless of which cluster node is currently running the NetWorker 
service. The first time NetWorker software runs, it creates the Client resource 
for the NetWorker virtual server. 

3. Make each cluster member within the cluster a client of the virtual NetWorker 
server. For each cluster member in the cluster:

a. Create a new client.

b. For the Name attribute, type the name of the virtual client.

c. For the Remote Access attribute, type the user@hostname of each physical node 
within the cluster, as follows:

root@clus_phys1

d. For the Group attribute, select a group.

The first time the NetWorker software runs, it creates the Client resource for 
the NetWorker virtual server. 

e. Perform the following steps: 

– Make the cluster nodes and the cluster default alias clients.
– Select only Save Set All for the cluster default alias. 
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f. Run a test probe to verify that the Client and Group resources have been 
properly configured.

On the node on which the NetWorker server resides, run the following 
command:

savegrp -pv -c client_name group_name

If the test probe does not display the correct scheduled backups and index, see 
“Tracking scheduled saves” on page 131.

Task 6: Configure cluster clients to a remote NetWorker server

To configure the cluster as a client of itself:

1. (Optional) Define save groups.

Note: In order for their save sets to restart after a virtual client or NetWorker server 
failover, save groups must have the Autorestart attribute enabled and the Manual Restart 
option disabled.

2. Make each physical client within the cluster a client of the NetWorker server. For 
each physical client in the cluster:

a. Create a new client.

b. For the Name attribute, type the name of the physical client.

3. Configure the cluster’s default alias as a NetWorker client:

a. Create a new client.

b. For the Name attribute, type the name of the default alias.

c. Complete the remaining attributes in the Client window.

d. Perform the following steps:

– Make the cluster nodes and the cluster default alias clients.
– Select only Save Set All for the cluster default alias. 

e. Run a test probe to verify that the Client and Group resources have been 
properly configured.

On the node on which the NetWorker server resides, run the following 
command:

savegrp -pv -c client_name group_name

If the test probe does not display the correct scheduled backups and index, see 
“Tracking scheduled saves” on page 131.

Task 7: Register NetWorker licenses for cluster server failover
To register NetWorker software in a cluster environment:

1. Type the following command on each node in the cluster:

ifconfig -a

The IP address of all interfaces, including the memory channel, appears.
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2. To determine the host ID for each node in the cluster, type the following 
command on any node:

hostid IP_address

hostid

3. Ensure to type the IP_address for all nodes in the cluster, including physical 
nodes and the memory channel. For example:

hostid 10.0.0.1

hostid 0xa000001

hostid 10.0.0.2

hostid 0xa000002

hostid 137.69.102.209

hostid 0xa894566d1

4. For each hexadecimal value, delete the 0x at the beginning. If the remaining 
hexadecimal value is less than eight digits, precede the value with an additional 
zero. 

For example:

0xa000001 becomes a000001 after you delete the 0x. 

5. Create a file named /nsr/res/hostids that contains the host IDs of all the cluster 
nodes by using the following syntax: hostid1:hostid2:hostid3:.

For example: 0a000001:0a000002:0a000003:

6. Register the NetWorker software.Chapter 10, ”Licensing and Enabling the 
Software,” provides details.

Uninstalling the cluster server
Before uninstalling the cluster server, shut down the NetWorker server. 

Note: If the NetWorker services are not shut down before attempting to uninstall the software, 
an error message will appear.

To delete the server package from the cluster:

1. From one node in the cluster:

a. Take the NetWorker service offline:

caa_stop networker

b. Type the following command to unregister the software:

caa_unregister networker

2. On each node in the cluster, run the following script to complete unregistering 
the software:

/usr/opt/networker/bin/networker.cluster -r

3. From one node in the cluster, remove the NetWorker subsets:

setld -d subset_names
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Note: When NetWorker release 6.x is removed, the /cluster_default_alias/nsr directory is 
automatically deleted. The /cluster_default_alias directory can be removed manually. The 
NetWorker Installation Guide provides instructions.

Connecting storage devices

Note: TruCluster Server, release 5.1B-3 or later, cannot enforce the NetWorker software’s 
exclusive access to autochanger devices. Consequently, tape operations by utilities other than 
NetWorker software might result in data loss. To make an autochanger jukebox an optional 
resource for the NetWorker server, register it as a CAA resource. This requires that you create 
profiles for all the devices (tape drives and media changers) on the cluster shared bus.

To register the autochanger as an optional resource for the NetWorker server:

1. Change directories to the following location:

/var/cluster/caa/profile

2. Create a media.cap file for each media change.

3. Create a tape.cap file for each tape drive. 

The following examples of the media.cap and tape.cap files illustrate the 
information that each file must contain:

mczero.cap file: 

NAME=mczero

TYPE=changer

DEVICE_NAME=/dev/changer/mc0

tapezero.cap:

NAME=tapezero

TYPE=tape

DEVICE_NAME=/dev/ntape/tape0_d1

tapeone.cap:

NAME=tapeone

TYPE=tape

DEVICE_NAME=/dev/ntape/tape1_d1

After creating the profiles, create a dependency from the profiles to the 
networker.cap file.

4. Create the dependency by editing the OPTIONAL _RESOURCES entry to contain 
the names of the media changer and tape drives. This is the only change required.

This example shows the networker.cap file, with the OPTIONAL _RESOURCES 
entry edited to contain the media changer and tape drive names from the 
mczero.cap and tape.cap files displayed in step 2:

NAME=networker

TYPE=application

ACTION_SCRIPT=/var/cluster/caa/script/networker.scr

ACTIVE_PLACEMENT=0

AUTO_START=0
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CHECK_INTERVAL=60

DESCRIPTION=NetWorker server

FAILOVER_DELAY=0

FAILURE_INTERVAL=0

FAILURE_THRESHOLD=0

HOSTING_MEMBERS=

OPTIONAL_RESOURCES=mczero tapezero tapeone

PLACEMENT=balanced

REQUIRED_RESOURCES=

RESTART_ATTEMPTS=1

SCRIPT_TIMEOUT=600

5. Continue with the configuration. Table 19 on page 117 provides more 
information. 

Relocating the NetWorker service
Each time the NetWorker server is relocated, the CAA software:

1. Shuts down all the NetWorker services on the node that are running the 
NetWorker server.

2. Restarts the client services, such as nsrexecd, on that system.

3. Starts the NetWorker service on the assigned cluster member. The /nsr link is 
redefined to point to the NetWorker service shared disk. 

The link to the /nsr directory that is configured as follows:

◆ On the cluster member running the NetWorker server:

/nsr ->/cluster/members/{memb}/nsr->/cluster_default_alias/nsr

◆ On each cluster member that is not running the NetWorker server:

/nsr -> /cluster/members/{memb}/nsr->

/var/cluster/members/{memb}/nsr

Shutting down and restarting the cluster server
The following section provides steps to shut down and restart the cluster server:

1. To shut down the NetWorker server in the cluster and stop all NetWorker server 
activity, type:

caa_stop networker

2. To manually restart the NetWorker server in the cluster, type:

caa_start networker
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Tracking scheduled saves
To verify that the Client and Group resources are properly configured, run a test 
probe for each client from the node where the NetWorker application is running:

savegrp -pv -c client_name group_name

If the test probe does not display all the scheduled save sets:

◆ Check the cluster configuration by using the cluster management software. If 
necessary, reconfigure the cluster.

◆ Ensure that the save sets defined for the client are owned by that client. If 
necessary, redistribute the client save sets to the appropriate Client resources. 

Note: Misconfiguration of the Cluster resources might cause scheduled save sets to be 
dropped from the backup. The NetWorker Administration Guide provides more information.

◆ Type this command to override scheduled save rules (not path ownership rules):

touch networker_bin_dir/pathownerignore

◆ Run a second test probe to verify the configuration.

This command allows any path to be backed up for a client, whether it is owned 
by the virtual client or physical node. The NetWorker Administration Guide 
provides more information.

If the pathownerignore command was used, check that the NetWorker scheduled 
save uses the correct client index. If the wrong index is used, the save sets can be 
forced to go to the correct index:

1. From the NetWorker Administration window, select a client and edit its 
properties.

2. For the Backup Command attribute, type the name of a backup script that 
contains 
save -c client_name

The EMC NetWorker Administration Guide provides details about the Backup 
Command attribute.
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Cluster Configuration
Figure 7 on page 134 displays a general cluster configuration consisting of two or 
more nodes and at least one virtual server. In this illustration:

◆ Node 1 is a computer with its own Local Disk.

◆ Node 2 is a computer with its own Local Disk.

◆ Virtual Server owns Shared Disks.

In this example, the virtual server, clus_log1, can fail over between Node 1 and Node 
2. However, the server runs only on one node at a time. 

The NetWorker client software runs on all the physical nodes within the cluster. This 
allows the backup of the physical client to proceed, as long as the node is running. 
Only one instance of the client software (nsrexecd) runs on each physical node within 
the cluster. The NetWorker client software is designed to recognize more than one 
client (physical client plus virtual client) that might be associated with a single 
physical node.

Figure 7 General cluster configuration

Note: The NetWorker Virtual server is not supported for the VERITAS Cluster server (VCS).
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Software requirements
Ensure that the following software is installed on each node in the cluster:

◆ Solaris 7, 8 or 9 operating environment with Veritas Cluster Server (VCS) 
required patches

◆ VERITAS Cluster Server 3.5, 4.0

◆ NetWorker release 7.4 Service Pack 1

◆ VERITAS Volume Manager VxVM 3.5, 4.0 (optional)

◆ VERITAS File System VxFS 3.5 (optional)

Note: —″ ″ ″ ″ ″ ″ ″ ″ ″ ″ ″ ″ ″ ″ ″ ″ ″ ″ ″ ″ ????A stand-alone or highly available (virtual) NetWorker server is 
not supported in the cluster. The NetWorker server must be outside the cluster. Storage nodes 
and a highly available Console server are also not supported in the cluster.

The EMC Information Protection Software Compatibility Guide provides the most 
up-to-date software and hardware requirements.

Installing only the NetWorker client software in a cluster
In this configuration, the NetWorker server is running on a node that is not a member 
of the cluster.

To install a NetWorker cluster client, perform the following:

◆ “Task 1: Prepare to install the software” on page 135

◆ “Task 2: Install the NetWorker cluster client software” on page 137

◆ “Task 3: Configure NetWorker client software as highly available” on page 137

◆ “Task 4: Register the NWClient resource type” on page 138

◆ “Task 5: Define the list of trusted NetWorker servers” on page 140

◆ “Task 6: Configure clients under the NetWorker server” on page 140

Note: —″ ″ ″ ″ ″ ″ ″ ″ ″ ″ ″ ″ ″ ″ ″ ″ ″ ″ ″ ″ ????Ensure that the NetWorker client software is installed on each 
node in the cluster.

Task 1: Prepare to install the software

To prepare to install the software:

1. Ensure that the Solaris operating environment and the VERITAS Cluster Server 
3.5, 4.0 software are already installed and configured on all cluster nodes.

2. If the VERITAS Cluster Server installation and configuration directories are 
different from the default directories, set the following environment variables:

• VCS_HOME

The default directory is /opt/VRTSvcs.

• VCS_CONF

The default directory is /etc/VRTSvcs.
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3. Ensure that the PATH environment variable includes /usr/sbin and 
$VCS_HOME/bin. The the default directory is /opt/VRTSvcs/bin.
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Task 2: Install the NetWorker cluster client software

To install NetWorker software on the computer designated as the NetWorker client:

1. Access the NetWorker software from the distribution media. 

The NetWorker Installation Guide provides detailed installation instructions.

2. Type the following command:

pkgadd -d .

Note: Do not press Enter for the default response All. Accepting the All response installs 
the server package.

3. Type the appropriate option number to install the client package.

4. (Optional) Type the appropriate option number to install the man pages.

5. Start the NetWorker daemons:

/etc/init.d/networker start

6. When all the applicable packages have been added, and the prompt appears, type 
q to exit.

Task 3: Configure NetWorker client software as highly available
To define and configure a NetWorker client as highly available:

1. Log in as root on each node where the NetWorker software is being installed.

2. Ensure that the /etc/hosts file on each cluster node contains the name of the 
virtual host. 

The virtual hostname can be published in the Domain Name System (DNS) or 
Network Information Services (NIS).

3. For each node in the cluster:

a. Run the cluster configuration script:

/usr/sbin/networker.cluster 

This script creates NWClient resource types that might need to be added later 
to the VERITAS Cluster Server configuration.

b. Type the following information in response to the prompts:

Enter directory where local NetWorker database is installed 
[/nsr]? 

– Type the location of the local NetWorker database directory provided 
during the installation procedure. For example:
/space/nsr

Do you wish to configure for both NetWorker server and 
client? Yes or No [Yes]? 

– Type No. This configures only the client software.

Note: Any changes to the configuration can be undone by running the networker.cluster -r 
option and then running the networker.cluster script again.
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Task 4: Register the NWClient resource type

You might need to configure an instance of the NetWorker Client resource type 
(NWClient) for virtual clients that own data on shared devices. Virtual clients in the 
VERITAS Cluster Server are IP type resources.

Depending on the VERITAS Cluster service group configuration, this task might not 
be required. Create an instance of NWClient resource type in VERITAS Cluster 
service groups that:

◆ Contain raw devices or logical volumes to back up.

◆ Contain more than one IP type resource.

◆ Are parallel with one or more IP type resources.

Creating an instance of NWClient resource type is optional if the following 
conditions exist:

◆ The failover VERITAS Cluster service group has only one IP type resource.

◆ The owned filesystems on the shared devices are instances of the mount type 
resource contained in the same service group.

Check the VERITAS Cluster Server configuration to determine which, if any, service 
groups require one or more NWClient resources. If no such groups require NWClient 
resources, proceed to “Task 5: Define the list of trusted NetWorker servers” on 
page 140.

About NWClient resources
Before performing this task, review the information in this section to become familiar 
with the structure of an NWClient resource. 

The NWClient resource type definition is:

type NWClient (

static str ArgList[] = { IPAddress, Owned_paths }

NameRule = NWClient_ + resource.IPAddress

static str Operations = None

str IPAddress

str Owned_paths[]

)

Table 20 on page 138 describes the required NWClient resource attributes.

Table 20 NWClient resource required attributes

Required attributes Type and dimension Definition

IPAddress string, scalar IP address of the virtual NetWorker client. 
An IP type resource with a matching Address attribute 
must exist in the service group.

Owned_paths string, vector A list of filesystems or raw devices on a shared storage 
device. These filesystems or raw devices are owned by the 
virtual NetWorker client specified by the IP Address 
attribute.
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Example 7 NWClient resource sample configuration

The following is a sample of a configured NWClient resource:

NWClient nw_helene (

IPAddress="137.69.104.251"

Owned_paths={ "/shared1", "/shared2", "/dev/rdsk/c1t4d0s4" }

)

Register resource type and create resource instances
This section describes how to register the NWClient resource and create NWClient 
resource instances.

To register the resource type and create resource instances:

1. Save the existing VERITAS Cluster Server configuration and prevent further 
changes while main.cf is modified:

haconf -dump -makero

2. Stop the VERITAS Cluster Server software on all nodes and leave the resources 
available:

hastop -all -force

3. Make a backup copy of the main.cf file:

cd /etc/VRTSvcs/conf/config
cp main.cf main.cf.orig

4. Copy the NWClient resource definition file that is in the VERITAS Cluster Server 
configuration directory:

cp /etc/VRTSvcs/conf/NWClient.cf /etc/VRTSvcs/conf 
/config/NWClient.cf

5. Add the NWClient resource type and the NWClient resource type instances by 
editing the main.cf file:

a. Add the NWClient resource type definition by adding an include statement to 
the main.cf file:

include "NWClient.cf"

b. Add an NWClient resource instance to every service group that contains an IP 
type resource and has associated filesystems or raw devices on shared storage. 

6. Save and close the file.

7. Verify the syntax of the file, /etc/VRTSvcs/conf/config/main.cf:

hacf -verify config

8. Start the VERITAS Cluster Server engine:

hastart

9. Log in on the remaining nodes in the cluster and start the VERITAS Cluster 
Server engine:

hastart

10. Verify the status of all service groups:

hagrp -display
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Task 5: Define the list of trusted NetWorker servers

Before a NetWorker server can back up a client, the client must grant the server 
access. Granting access is controlled by the servers file. For the node that is currently 
running the NetWorker server resource group, this file is located in the globally 
mounted filesystem. Otherwise, this file is located on a local disk. 

Note: —″ ″ ″ ″ ″ ″ ″ ″ ″ ″ ″ ″ ″ ″ ″ ″ ″ ″ ″ ″ ????If the /nsr/res/servers file is empty or does not exist, any 
NetWorker server is authorized to:
- Access and backup the client.
- Perform a directed recovery to the client.

To define the list of trusted NetWorker servers, perform the following steps on each 
node in the cluster:

1. Shut down the NetWorker processes and verify that all daemons have stopped:

nsr_shutdown
ps -ef |grep nsr

2. Edit or create the /nsr/res/servers file and add the set of NetWorker servers, one 
per line, that require access to this client.

3. Check the NetWorker boot-time startup file to see whether nsrexecd is being run 
with the -s option. If the -s option exists, remove all occurrences. For example:

-s servername

4. Restart the NetWorker daemons:

/etc/init.d/networker start

Task 6: Configure clients under the NetWorker server

To configure each client under the NetWorker server:

1. (Optional) Define save groups.

Note: In order for their save sets to restart after a virtual client or NetWorker server 
failover, save groups must have the Autorestart attribute enabled and the Manual Restart 
option disabled.

2. Make each physical Client within the cluster a client of the NetWorker server. For 
each physical client in the cluster:

a. Create a new client.

b. For the Name attribute, type the name of the physical client.

3. Make each virtual client within the cluster a client of the NetWorker virtual 
server. For each virtual client in the cluster:

a. Create a new NetWorker client. 

b. For the Name attribute, type the name of the virtual client.

c. For the Remote Access attribute, add entries for each physical client within 
the cluster. For example: 

root@clus_phys1
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d. For the Group attribute, select a group.

The first time the NetWorker application runs, it creates the Client resource for 
the NetWorker virtual server. 

4. Run a test probe to verify that the Client and Group resources have been properly 
configured. 

On the node on which the NetWorker server resides, type:

savegrp -pv -c client_name group_name

If the test probe does not display the scheduled back ups and index, see “Tracking 
scheduled saves” on page 141.

Uninstalling the NetWorker software
To uninstall the NetWorker software from a cluster environment: 

1. On one node in the cluster, remove all the instances of NWClient resource types 
and remove the NWClient type definition from the configuration.

For information, refer to the hares (1m) and hatype(1m) man pages.

2. On each node in the cluster:

a. Log in as root on the computer from which the software is being removed.

b. Undo all changes to the configuration by running the networker.cluster -r 
option.

c. To shut down the NetWorker daemons, type:

nsr_shutdown

A list of NetWorker daemons to be shut down appears, and you are prompted 
whether to continue.

d. To remove the software, type:

– All the packages:
pkgrm LGTOclnt LGTOman

– Only the client package:
pkgrm LGTOclnt

– Only the man pages:
pkgrm LGTOman

Tracking scheduled saves
To verify that the Client and Group resources are properly configured, run a test 
probe for each client from the node where the NetWorker application is running:

savegrp -pv -c client_name group_name

If the test probe does not display all the scheduled save sets:

◆ Check the cluster configuration by using the cluster management software. If 
necessary, reconfigure the cluster.

◆ Ensure that the save sets defined for the client are owned by that client. If 
necessary, redistribute the client save sets to the appropriate Client resources. 
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Note: Misconfiguration of the Cluster resources might cause scheduled save sets to be 
dropped from the backup. The NetWorker Administration Guide provides more information.

◆ Type this command to override scheduled save rules (not path ownership rules):

touch networker_bin_dir/pathownerignore

◆ Run a second test probe to verify the configuration.

This command allows any path to be backed up for a client, whether it is owned 
by the virtual client or physical node. The NetWorker Administration Guide 
provides more information.

If the pathownerignore command was used, check that the NetWorker scheduled 
save uses the correct client index. If the wrong index is used, the save sets can be 
forced to go to the correct index:

1. From the NetWorker Administration window, select a client and edit its 
properties.

2. For the Backup Command attribute, type the name of a backup script that 
contains 
save -c client_name 

The EMC NetWorker Administration Guide provides details about the Backup 
Command attribute.
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How NetWorker software is licensed
NetWorker software and added features, such as modules, are installed in evaluation 
mode with all of the features enabled. The licensing of NetWorker software means 
entry of enabler and authorization codes on the server for the NetWorker 
environment. Without these codes, the software or added features will not run 
beyond the evaluation period.

Each installation of NetWorker server software must be licensed with a base enabler. 
This enabler “turns on” the software and allows you to use a particular bundle of 
features, such as a specified number of clients and devices. All licensing takes place 
on the server. The licenses are entered and stored on the server. The server enforces 
the licensing.

Base enablers come in different editions, which enable varying degrees of 
functionality. Add-on enablers allow a broader scope of features.

The steps in this chapter assume that the NetWorker software is installed and that all 
of the software and hardware requirements have been met on the computer that will 
access the NetWorker Management Console.

The evaluation process
You can evaluate NetWorker software two ways:

◆ By evaluating a new installation of the software on a NetWorker server.

◆ By evaluating NetWorker features on an existing NetWorker installation.

Evaluating a new installation
When you first install the NetWorker software, you can evaluate it with all the 
modules and features for 30 days free without entering any codes.

By the end of the evaluation period, you must purchase, enter, and authorize a base 
enabler to continue to use the NetWorker software to back up data. The base enabler 
is the license that enables the edition purchased. 

To continue to use some of the modules and features that were available with the 
evaluation software, you might need to purchase add-on enablers, depending on the 
edition of the base enabler.

Evaluating features on an existing installation
If you are evaluating one or more NetWorker Modules or features on an edition of 
NetWorker software that has already been installed and enabled, enter a temporary 
enabler for each module or feature. The temporary enabler is valid for 45 days. 

To obtain a temporary enabler code, do one of the following:

◆ Go to the http://Powerlink.EMC.com website, select Support > Product 
Registration and License Keys, and then follow the instructions for your 
product.

◆ Refer to the EMC Information Protection  Media Kit. 
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By the end of the evaluation period, you must purchase, install, and authorize the 
corresponding license enablers to continue to use modules or features you have 
evaluated. “The licensing process” on page 145 provides instructions.

How to enter a temporary enabler code

CAUTION!
The temporary enabler code is valid on only one computer in a network. If you 
enter the same code on more than one computer in a network, a copy protection 
violation error occurs and the NetWorker server software is disabled on all 
NetWorker servers with duplicate enablers.

To enter the temporary enabler code:

1. Start the NetWorker Management Console software.

2. Open the Administration window:

a. In the Console window, click Enterprise.

b. In the left pane, select a NetWorker server in the Enterprise list.

c. In the right pane, select the application.

d. From the Enterprise menu, click Launch Application. 

The Administration window is launched as a separate application.

3. From the Administration window, click Configuration.

4. In the left pane, select Registration.

5. From the File menu, select New.

6. In the Enabler Code attribute, type the enabler code.

7. In the Name attribute, type the name of the license.

8. (Optional) In the Comment attribute, type a description of the license.

9. Click OK.

The licensing process
To permanently use NetWorker software, you must purchase and enter a license 
enabler code, and then authorize it. This licensing process is the same for all editions 
of NetWorker software as well as for individual modules and features. 

The license enabler code that you purchase is valid for 45 days, as a registration 
period. During the registration period, you must obtain and enter a corresponding 
authorization code.

These sections explain how to enter and authorize the license enabler: 

◆ “Task 1: Enter the license enabler code” on page 146

◆ “Task 2: Obtain an authorization code” on page 146

◆ “Task 3: Enter the authorization code” on page 147
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Task 1: Enter the license enabler code

Note: To save time when entering multiple licenses, enter the base enabler last. Otherwise, 
once a base enabler is entered, devices that do not yet have licenses entered may be disabled. 
Those devices would have to be reenabled manually after their licenses are installed.

To enter the license enabler code:

1. Start the NetWorker Management Console software.

2. Open the Administration window:

a. In the Console window, click Enterprise.

b. In the left pane, click a NetWorker server in the Enterprise list.

c. In the right pane, click the application.

d. From the Enterprise menu, select Launch Application. 

The Administration window is launched as a separate application.

3. In the Administration window, click Configuration.

4. In the left pane, select Registrations.

5. From the File menu, select New. 

The Create Registration dialog box appears.

6. In the Enabler Code attribute, type the enabler code.

7. In the Name attribute, type the name of the license.

8. (Optional) In the Comment attribute, type a description of the license.

9. Click OK.

The new license is added and appears in the right pane. Repeat Step 1 to Step 9 to add 
any additional enabler codes.

After you type a license enabler code, you have 45 days as a registration period to 
authorize the NetWorker software.

Task 2: Obtain an authorization code
Registration of NetWorker software occurs by obtaining an authorization code. 

To obtain a unique authorization code:

1. Go to the http://Powerlink.EMC.com website.

2. Select Support > Product Registration and License Keys and follow the 
instructions for your product. 

IMPORTANT!
If the software or feature is not authorized by the end of the 45-day registration 
period, the NetWorker backup function or feature is disabled. However, data that 
was backed up during the registration period can still be recovered from local 
devices.
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Task 3: Enter the authorization code

To complete the licensing process, you must enter the unique authorization code on 
the NetWorker server within 45 days of entering the license enabler code.

If the authorization process is successful, the expiration date for the license displays:

Authorized - No expiration date.

If the authorization is not verified in this way, contact the 
http://Powerlink.EMC.com website.

To avoid an interruption in scheduled backups if you move the NetWorker software 
from one computer to another, or to change the network address of a computer after 
the software is installed, perform one of the following:

◆ Obtain a new authorization code. You need the host ID of the original server as 
well as the new server. The host ID appears in the server’s Registration window. 

◆ Install and configure the NetWorker License Manager software. “Managing 
licenses” on page 149 provides information on use of the NetWorker License 
Manager, and the latest NetWorker License Manager Installation and 
Administration Guide.

To enter the authorization code:

1. Start the NetWorker Management Console software.

2. Open the Administration window:

a. In the Console window, click Enterprise.

b. In the left pane, select a NetWorker server in the Enterprise list.

c. In the right pane, click the application.

d. From the Enterprise menu, select Launch Application. 

The Administration window is launched as a separate application.

3. In the Administration window, click Configuration.

4. In the left pane, select Registration. 

5. In the right pane, select a license.

6. From the File menu, select Properties.

7. In the Auth Code attribute, type the authorization code for the product. The 
authorization code is the code assigned to the specified permanent enabler or 
update enabler code.

8. Click OK.

The license is now permanently enabled.
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Update enablers

To update existing NetWorker software to a major release, an update enabler is 
necessary. Update enablers are required for any major NetWorker software upgrade 
from release 4.0 and later, including the current NetWorker release. To use the 
NetWorker License Manager, the NetWorker server must be release 5.0 or later.

With a first-time purchase of NetWorker software, a one-year update agreement may 
be included. After a year, an update enabler may be acquired with a new update 
agreement purchase.

Table 21 on page 148 lists the NetWorker releases that require update enablers.

Additional licenses

This section describes a few of the additional licenses required to operate some of the 
NetWorker features.

Client connection licenses
Every computer to be backed up in a NetWorker datazone requires a client 
connection license, even the NetWorker server. The client connection license may be 
one of the licenses that is supplied with the base enabler or purchased separately. A 
cluster client or NDMP data server requires a special type of client connection license.

Storage nodes
Each storage node requires a storage node license, in addition to its client connection 
license. A dedicated storage node, which allows the storage node to back up only 
itself, is licensed separately.

Table 21 NetWorker update enablers

Upgrade from to 5.0 to 5.5 to 5.5.x to 5.6 to 5.7 to 6.x to 7.0 to 7.1 to 7.2 to 7.3 to 7.4.x

Any release prior 
to 5.0 

yes yes yes yes yes yes yes yes yes yes no

5.0 yes yes yes yes yes yes yes yes yes no

5.5 yes yes (UNIX 
only)

yes 
(NT only)

yes yes yes yes yes no

5.5.x yes (UNIX 
only)

yes 
(NT only)

yes yes yes yes yes no

5.6 NA* yes yes yes yes yes no

5.7 yes yes yes yes yes no

6.0 no yes yes yes yes no

7.0 yes yes yes no

7.1 yes yes no

7.2 yes no

7.3 yes no

Note: * Release 5.6 is UNIX only, and release 5.7 is Microsoft Windows only. NT refers to Microsoft Windows NT.
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NetWorker Application Modules 
NetWorker Application Modules are licensed on the basis of one enabler per 
database type host. For example, to back up the Oracle database on two hosts, two 
NetWorker Module for Oracle enablers are required, even if the two hosts are backed 
up by the same server. However, if multiple database instances are running on a 
NetWorker client host, only one NetWorker Module enabler is required for that one 
host.

Cluster clients
For each physical node in a cluster, you must purchase a Cluster Client Connection. 
The NetWorker Administration Guide provides information on how to license 
computers in a cluster.

NDMP licensing
NDMP licensing requires one NDMP Client Connection per NAS array. 

Managing licenses
The NetWorker License Manager software provides centralized license management, 
which enables you to maintain all of an enterprise’s NetWorker licenses from a single 
computer. With the NetWorker License Manager, you can move NetWorker software 
from one computer to another, or change the IP address on an existing NetWorker 
server without having to reauthorize the software. The NetWorker License Manager 
can be installed as an option during the NetWorker software installation.

To begin to implement the NetWorker License Manager:

1. Obtain bulk enabler codes. For contact information, go to 
http://Powerlink.EMC.com.

2. Install the NetWorker License Manager software.

3. Configure the NetWorker License Manager software.

4. Configure the NetWorker servers to access the NetWorker License Manager for 
their licenses.

The latest NetWorker License Manager Installation and Administration Guide 
provides more information on how to install and use the NetWorker License 
Manager.
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